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Inhaltsverzeichnis

1. Registrieren und freischalten

Lernen Sie, wie Sie Goldfish registrieren und freischalten, so dass es ohne Einschränkungen

arbeitet.

2. Projekt

Lernen Sie wie Sie ein Goldfish Projekt beginnen. Das ist der erste Schritt wenn Sie Ihre Website

mit Goldfish entwerfen.

3. Seite

Lernen Sie wie Sie die Seitenstruktur Ihrer Website mit Seiten und Unterseiten erstellen.

4. Seitenvorlage

Lernen Sie wie Sie Seitenvorlagen verwenden. Legen Sie den hauptsächlich verwendeten

Hintergrund für alle Seiten Ihrer Website fest.

5. Seitenbereich

Teilen Sie die Seiten Ihrer Website in Bereiche auf. Z.B. ein Bereich für den Kopf, die Navigation,

den Fuß und den Inhalt.

6. Bereichsvorlage

Lernen Sie wie Sie Bereichsvorlagen verwenden. Entwerfen Sie das hauptsächlich von den

Seiten genutzte Layout Ihrer Website.

7. Text

Füllen Sie Ihre Website mit Inhalt und fügen Sie Text hinzu.

8. Bild

Bilder sind sehr wichtig für das Design Ihrer Website. Die Bildkomponente in Goldfish hat schlaue

Funktionen um Bilder zu bearbeiten und anzuzeigen.

9. Multimedia

Fügen Sie Ihrer Website QuickTime, Flash, RealMedia und Windows Media Dateien hinzu.

10. Navigationsmenü

Fügen Sie ein Navigationsmenü zu Ihrer Website hinzu. Ein Navigationsmenü ist das wichtigste

Element, das Seitenbesucher verwenden um auf Ihrer Website zu navigieren.

11. Form

Mit Formen können Sie Rechtecke, abgerundete Rechtecke, Ovale und Linien direkt auf Ihrer

Website zeichnen.
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12. Galerie

Mit einer Galerie können Sie den Seitenbesuchern dutzende Fotos in einer Diashow

präsentieren.

13. Besucherzähler

Fügen Sie Ihrer Website einen Besucherzähler hinzu. Mit einem Besucherzähler können Sie die

Anzahl der Besucher auf Ihrer Website anzeigen.

14. Formular

Fügen Sie ein Kontaktformular zu Ihrer Website hinzu. Mit diesem Formular können Ihnen die

Besucher Nachrichten senden.

15. Website Frame

Mit einem Website Frame können Sie eine externe Website direkt auf Ihrer Website anzeigen.

16. HTML Code

Verwenden Sie einen HTML Code Container um Ihren eigenen HTML Code zu einer Seite

hinzuzufügen und erweitern Sie so die Funktionalität von Goldfish.

17. Path

Show the path to the current page on your website to provide a clearer navigation.

18. Comments and Guestbook

Add a comments field or a guestbook to your website and receive feedback from the visitors of

your website.

19. Store

Create a store and add products and a shopping cart to your website and start your business

online.

20. Publish Website

Publish your website immedialtely on the internet with the built in ftp client.

21. Build your Website

Build your website on the desktop and get all neccessary files, which you can upload to a

webserver.

22. Import Media

Learn how you can import and process media files like images, movies and documents in

Goldfish.

23. Working with Fonts

There are several things you should know if you work with fonts and font styles on websites. 
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24. Creating Webapplications

Create web applications with Goldfish Professional in your prefered language (e.g. PHP).

25. Export a Design

Export your work as Goldfish design. Build websites from your design or deliver it to your clients.

26. Preferences

In the preferences, you can change the behavior of Goldfish.

27. Trouble and Errors

Learn what you can do if errors occure, if you find bugs or if you have trouble using Goldfish.

28. Goldfish Short Keys

Learn how to use Short Keys in Goldfish. This article contains a full list of all short keys for

Goldfish.
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1. Registrieren und freischalten
Lernen Sie, wie Sie Goldfish registrieren und freischalten, so dass es ohne

Einschränkungen arbeitet.

Wenn Sie mit der Testversion von Goldfish arbeiten, sehen Sie das folgende Fenster beim

Programmstart. Websites zu erstellen und Websites zu veröffentlichen ist deaktiviert. Bitte kaufen

SIe die Vollversion wenn Sie Ihre Website mit Goldfish erstellen möchten.

Klicken Sie auf Lizenz kaufen. Das bringt Sie auf unsere Website, auf der Sie Goldfish kaufen

können. Sie können zwischen Goldfish Standard und Goldfish Professional wählen.

Wenn Sie Goldfish gekauft haben, erhalten Sie Ihre Serienummer per E-Mail. Kopieren Sie

beides, den Namen bei Registriert auf und die Seriennummer und fügen Sie es in die

entsprechenden Felder ein. Klicken Sie danach auf Freischalten.
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1: Registrieren und freischalten

Goldfish arbeitet ab jetzt ohne Einschränkungen. Falls Sie eine Seriennummer für ein Upgrade

eingegeben haben, fragt Goldfish nach der Seriennummer einer früheren Version, die Sie gekauft

haben. Geben Sie die alte Seriennummer ein (falls die Felder noch nicht gefüllt sind) und klicken

Sie auf OK.

Wenn Sie Goldfish Standard gekauft haben, können Sie jederzeit auf Goldfish Professional

upgraden. Wählen Sie Goldfish > Goldfish kaufen... aus dem Menü (Macintosh) oder  ? >

Goldfish kaufen... (Windows).
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1: Registrieren und freischalten

Klicken Sie auf Lizenz kaufen und kaufen Sie eine Lizenz für ein Upgrade auf Goldfish

Professional. Der Freischalteprozess ist genau der selbe wie bei einem Upgrade von einer

älteren Version.
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2. Projekt
Lernen Sie wie Sie ein Goldfish Projekt beginnen. Das ist der erste Schritt wenn Sie Ihre

Website mit Goldfish entwerfen.

Wenn Sie ein neues Projekt beginnen, müssen Sie sich entscheiden ob Sie ein Design

verwenden möchten oder mit einem leeren Layout beginnen wollen. Wenn Sie mit einem Design

beginnen müssen Sie das Layout Ihrer Website nicht selbst entwerfen. Mit einem leeren Layout

ist es mehr Arbeit aber das Ergebnis ist eine Website mit Ihren speziellen Designideen.

Wählen Sie Ablage > Neu im Menü.  Ein neues Projektfenster erscheint und alle installierten

Designs werden angezeigt. Es sind viele weitere Designs auf unserer Website verfügbar. Klicken

Sie auf Weitere Designs und Sie gelangen auf unsere Design Downloadwebsite. Wählen Sie ein

Design oder Leere Website und klicken Sie auf OK.
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2: Projekt

Das Projektfenster ist in 3 verschiedene Bereiche aufgeteilt. Die Projektliste (1). Alle

Komponenten Ihrer Website werden hier aufgelistet. Seiten (mit der Startseite als erste Seite),

Seitenvorlagen und Bereichsvorlagen. Im Editor (2) können Sie Text eingeben und den Inhalt

Ihrer Website editieren.

Der Editor ist im Moment leer (das Goldfish Icon wird angezeigt), weil Sie nichts ausgewählt

haben. In den Eigenschaften (3) können Sie alle Eigenschaften einer ausgewählten Komponente

sehen und editieren. Im Moment sind die Eigenschaften des Projekts sichtbar, weil Sie nichts

ausgewählt haben.

Das Seitenmodell von Goldfish
Goldfish erstellt Seiten in einer innovativen und einmaligen Weise. Es stehen flexible

Komponenten zu Verfügung wie z.B. Seiten, Seitenbereiche, Textfelder oder Bildobjekte. Eine

Seite wird aus 3 verschiedenen Ebenen gebildet.
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2: Projekt

Eine Seite (grau) ist die Basis. Auf einer Seite gibt es Seitenbereiche (gelb), die die einzelnen

Bereiche Ihrer Website repräsentieren (Seitenkopf, Seitenfuß, Navigation, Hauptbereich usw.).

Ein Seitenbereich enthält Komponenten (grün). Komponenten repräsentieren den Inhalt Ihrer

Website wie Bilder, Filme oder Text.

Die Projektliste
Sehen Sie sich die Projektliste an: Wenn Sie Ihre Website mit einem Design begonnen haben

existieren dort bereits Seiten, Seitenvorlagen und Bereichsvorlagen. Die Startseite ist die erste

Seite Ihrer Website. Wenn die Besucher Ihrer Website die Internetadresse eingeben, wird die

Startseite geladen.

Normalerweise verwendet eine Website auf allen Seiten das selbe Layout. Sie können eine

Layoutvorlage in Seitenvorlagen hinterlegen und auf allen Seiten verwenden um ihre

Eigenschaften mit dem Layout der Seitenvorlage zu überschreiben. Sie können eine Layotvorlage

in Beriechsvorlagen hinterlegen und sie in Seitenbereichen auf jeder Seite verwenden.

Vorlagen speichern das Design und den Stil für verschiedene Seiten und Seitenbereiche zentral

an einer Stelle. Das ist nützlich wenn Sie etwas ändern wollen wie z.B. die Hintergrundfarbe für

alle Seiten. Wenn Sie keine Seitenvorlagen verwenden müssen Sie die Farbe auf jeder Seite

separat ändern. Wenn Sie eine Seitenvorlage erstellt haben, müssen Sie nur die

Hintergrundfarbe in der Seitenvorlage ändern und die Änderung wird auf alle Seiten angewendet,

die die Seitenvorlage verwenden.

Wenn Sie Ihr Projekt mit einem Design begonnen haben, ist der nächste Schritt Seiten zu

erstellen. Wenn Sie Ihr Projekt mit einem leeren Layout begonnen haben, sollten Sie

Seitenvorlagen und Bereichsvorlagen für das Layout bearbeiten und erst im folgenden Schritt die

Seiten erstellen.
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2: Projekt

Eigenschaften für Projekt
Diese Eigenschaften können für das Projekt gesetzt werden. Wählen Sie nichts aus (das Goldfish

Icon wird im Editor angezeigt), um die Eigenschaften des Projekts anzuzeigen.

Projekt > Meta Tags

Meta Tags werden von älteren Suchmaschinen verwendet um Ihre Website zu finden. Hier

können Sie projektweite Meta Tags eingeben. Projektweite Meta Tags erscheinen auf jeder Seite

von Ihrer Website. Wenn Sie für eine Seite spezifische Meta Tags setzten möchten, müssen Sie

die Meta Tag Eigenschaft einer Seite verwenden.

 Fügt einen neuen Meta Tag hinzu.

 Löscht einen ausgewählten Meta Tag.

Geben Sie den Wert von name oder http-euiv bei Meta Tag Name in der Liste ein. Geben Sie den

Wert von content bei Meta Tag Wert ein. Wenn der Meta Tag mit <meta http-equiv= beginnt,

aktivieren Sie die Checkbox bei http-equiv.

Wenn Sie Ihre Meta Tags editiert haben, klicken Sie auf OK.

Projekt > Internetadresse (URL)

Geben Sie die absolute Internet URL Ihrer Website ein. Z.B. http://www.meinewebsite.de. Das

wird benötigt wenn Sie RSS Feeds auf Ihrer Website verwenden.

Projekt > Favoritenicon

Hier können Sie ein FavIcon für Ihre Website wählen. Ein FavIcon ist ein kleines Bild, das in der

Adressbar angezeigt wird (die Fishbeam Website verwendet einen kleinen Fisch als FavIcon).

FavIcon müssen Windows .ico Dateien sein, um im Internet Explorer angezeigt zu werden. Safari,

Firefox und die anderen erlauben außerdem .gif oder .png Dateien.
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2: Projekt

Projekt > IE 6 Warnung

Zeigt eine Warnung, falls der Besucher Ihrer Website Internet Explorer 6 oder ältere Versionen

verwendet. Goldfish Websites sind nicht kompatibel zu Internet Explorer 6.

Projekt > Warnungserklärung

Detailliertere Warnung für Internet Explorer 6 Benutzer.

Projekt > Adminpasswort

Das Passwort wird benötigt, wenn Sie Kommentare in der Kommentarfunktion löschen möchten.

Projekt > Eingebettete Medien

Klicken Sie in Wählen... um eine Liste der eingebetteten Mediendateien Ihres Projekts zu sehen.

Alle Bilder, Filme oder anderen Dateien, die Sie auf Ihrer Website verwenden sind im Projekt

eingebettet.

Die Beschreibung jeder Mediendatei wird unterschiedlich verwendet. Z.B. als Untertitel eines

Bildes in einer Bildergalerie, als alt Parameter für Bilder oder als Titel für Downloadlinks. Machen

Sie einen Doppelklick auf einen Namen oder eine Beschreibung um sie zu editieren. Beachten

Sie, dass es Beschränkungen für den Namen gibt (keine Leerzeichen, keine Sonderzeichen, die

richtige Dateiendung). Falls Sie einen falschen Namen eingegeben haben ertönt ein

Warngeräusch und der alte Name wird weiterhin verwendet.

Klicken Sie aufOK um das Fenster für eingebettete Medien zu schließen.

Projekt > Schriftvorlagen

Sie können Schriftvorlagen verwenden um Schriftstile zu speichern, die Sie oft auf Ihrer Website

verwenden. Meistens verwendet eine Website nur wenige verschiedene Schriftstile. Klicken Sie

auf Wählen... um das Schriftvorlagen Fenster zu öffnen.
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2: Projekt

Die erste Schriftvorlage auf der Liste ist die Standardvorlage. Hier können Sie den hauptsächlich

verwendeten Schriftstil für Ihre Website festlegen. Wenn Sie keine bestimmte Schriftart für

andere Schriftvorlagen oder Komponenten bestimmen, wird die Schriftart der Standardvorlage

verwendet.

 Eine Schriftvorlage hinzufügen.

 Eine ausgewählte Schriftvorlage duplizieren.

 Eine ausgewählte Schriftvorlage löschen.

 Öffnet den Editor für Schriftstile und Sie können die ausgewählte Schriftvorlage editieren.

Machen Sie einen Doppelklick auf eine Schriftvorlage um sie umzubenennen. Bitte lesen Sie die

Dokumentation für das arbeiten mit Schriften um zu lernen wie das Schriftsystem in Goldfish

funktioniert.

Statistik > Statistik für iPhone hinzufügen

Fügt eine Webapplikation hinzu, die Besuchsstatistiken für Ihre Website direkt auf Ihrem iPhone

anzeigt. Andere Mobiltelefone werden nicht unterstützt.
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2: Projekt

Um das Statistik Programm aufzurufen, öffnen Sie Safari und geben Sie 

http://www.meinewebsite.de/support/stats ein. Verwenden Sie die Adresse von Ihrer Website

anstatt http://www.meinewebsite.de die Adresse Ihrer Website. Falls Sie den Wert bei Name des

Supportordners in den Einstellungen geändert haben, verwenden Sie den neu eingegebenen

Namen anstatt support. Fügen Sie die Webapplikation zu Ihrem Homebildschirm hinzu, um sie

später einfacher zu erreichen.

Statistik > Heute

Text in der Benutzeroberfläche für Heute.

Statistik > Diesen Monat

Text in der Benutzeroberfläche für Diesen Monat

Statistik > Dieses Jahr

Text in der Benutzeroberfläche für Dieses Jahr

Statistik > Gesamt

Text in der Benutzeroberfläche für Gesamt

Statistik > Gesamtformat

Format in der Benutzeroberfläche für Gesamtwerte. Verwenden Sie %1 als Platzhalter für den
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2: Projekt

Wert.

Statistik > Zeitformat

Format in der Benutzeroberfläche für die Stunde des Tages. Verwenden Sie %1 als Platzhalter

für die Stunde.

Statistik > Tagesformat

Format in der Benutzeroberfläche für den Tag des Monats. Use %1 Verwenden Sie %1 als

Platzhalter für den Tag.

Statistik > Monatsformat

Format in der Benutzeroberfläche für den Monat. Verwenden Sie %1 als Platzhalter für den

Monat und %2 als Platzhalter für das Jahr.

Statistik > Website öffnen

Text in der Benutzeroberfläche für Website öffnen

Google > Google Analytics

Google Analytics ist ein kostenloser Service von Google. Mit Google Analytics können Sie

komplette und detailierte Nutzerstatistiken für Ihre Website erhalten. Google stellt Ihnen eine

Google Analytics Tracker Id um Ihre Website zu identifizieren. Geben Sie diese Id hier in Goldfish

ein. Die Id wird in dieser Form geliefert:  UA-XXXXXX-X.

Google > Webmaster Tools

Google Webmaster Tools ist ein kostenloser Service von Google. Mit Google Webmaster Tools

können Sie Ihre Website für die Google Suchmaschine optimieren. Google liefert Ihnen einen

Meta Tag in dieser Form: \. Geben Sie nur den Inhalt dieses Metatags ein: XXXXXXXXXXXXX.
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3. Seite
Lernen Sie wie Sie die Seitenstruktur Ihrer Website mit Seiten und Unterseiten erstellen.

Jede Website besteht aus verschiedenen Seiten, die hierarchisch geordnet sind. Alle Seiten Ihres

Projekts sind in der Projektliste auf der linken Seiten in einem Projektfenster aufgelistet.

Die erste Seite ist die Startseite Ihres Projekts (das Welt Icon). Das ist die Seite, die geladen wird,

wenn der Besucher Ihre Internetadresse eingibt (z.B. http://www.fishbeam.com). Alle anderen

Seiten sind Unterseiten der Startseite.

 Klick und Seite hinzufügen. Eine neue Seite erscheint unter der Startseite.

 Dupliziert eine ausgewählte Seite mitsamt ihrem Inhalt.

 Löscht eine ausgewählte Seite.

Eine Website enthält normalerweise eine komplexe Seitenstruktur mit Seiten und Unterseiten.

Um Unterseiten zu erzeugen, ziehen Sie eine Seite in eine andere Seite.

INFO: Sie können Die Reihenfolge der Projektliste mit Drag und Drop ändern. Bewegen Sie

Seiten hoch und runter um die korrekte Seitenstruktur zu bilden.

Der voreingestellte Name für Seiten ist >seite.htm, seite_1.htm... Um eine Seite umzubenennen,

klicken Sie doppelt auf ihren Namen. Beachten Sie, dass Sie nur Buchstaben, Zahlen und _ für

den Namen verwenden dürfen. Falls die Seite eine Dateiendung hat (Seiten mit Unterseiten

haben keine, weil sie eigentlich ein Ordner mit einer Index Datei sind), entfernen Sie nicht die

Dateiendung. Falls Sie einen nicht erlaubten Namen eingegeben haben, wird der alte Name

weiter verwendet.
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3: Seite

Eigenschaften für Seite
Diese Eigenschaften können für eine Seite gesetzt werden. Wählen Sie eine Seite aus, aber

nichts auf der Seite um die Eigenschaften der Seite zu sehen.

Seite > Titel

Titel der Seite. Der Titel wird als Beschriftung des Browserfensters angezeigt.

Seite > Menütitel

Der Menütitel wird in allen Navigationsmenüs angezeigt, die einen Link auf die Seite enthalten.

Deaktivieren Sie ihn und die Seite wird nicht im Menü angezeigt.

Seite > Meta Tags

Hier können Sie die Meta Tags für diese Seite editieren. Anders als bei projektweiten Meta Tags

sind die seitenweiten Meta Tags nur für diese Seite. Bitte lesen Sie die Dokumenation des

Projekts um zu lernen wie der Meta Tag Editor funktioniert.

Seite > Seitenvorlage

Wählen Sie eine Seitenvorlage, wenn Sie den Stil der Seite mit einer Seitenvorlage

überschreiben möchten. Beachten Sie, dass alle Eigenschaften, die für den Stil verantworlich

sind ausgeblendet werden, wenn Sie eine Seitenvorlage gewählt haben. Der Stil wird dann von

der Seitenvorlage kontroliert.

Seite > Seitenbreite (min)

Setzt die minimale Breite der Seite (Pixel). Wenn das Browserfenster kleiner ist, werden

Scrollbalken angezeigt. Die Breite eines Seitenbereichs muss kleiner oder die selbe wie die

Seitenbreite sein. Sie können keine minimale Seitenhöhe einstellen, weil die Höhe durch die

minimale Höhe von allen Seitenbereichen festgelegt wird.

Seite > Position des Inhalts

Wählen Sie die Positionierung des Inhalts, wenn das Browserfenster größer als Seitenbreite (min)

ist.

Seite > Seitenrand links

Setzt den Abstand von der linken Seite zum Seiteninhalt.

Seite > Seitenrand rechts

Setzt den Abstand von der rechten Seite zum Seiteninhalt.

Seite > Seitenrand oben

Setzt den Abstand von der oberen Seite zum Seiteninhalt.

Seite > Seitenrand unten

Setzt den Abstand von der unteren Seite zum Seiteninhalt.
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3: Seite

Seite > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für die Seite.

Seite > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Seite > Hintergrundbild

Wählen Sie ein Hintergrundbild für die Seite. Mit Wiederholen können Sie einstellen wie das Bild

angezeigt werden soll.

Seite > HTML Ausgabe deaktivieren PRO

Erzeugt eine Seite ohne jeglichen Inhalt oder HTML Code. Verwenden Sie diese Option nur,

wenn Sie ein Script schreiben möchten, das die HTML Codeausgabe übernimmt.

Seite > Code vor dem Dokument hinzufügen PRO

Fügen Sie Code hinzu, bevor das HTML Dokument beginnt. Das wird von machen Scripts

gebraucht (z.B. wenn Sie Sessions in PHP verwenden möchten).

Seite > Header HTML Code hinzufügen PRO

Fügt ihrer Seite eigenen HTML Code im Headbereich hinzu um die Funktionalität von Goldfish zu

erweitern.

Seite > HTML Code hinzufügen PRO

Fügt Ihrer Seite eigenen HTML Code im Bodybereich hinzu um die Funktionalität von Goldfish zu

erweitern.

Seite > Stylesheets hinzufügen PRO

Fügt Ihrer Seite eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

RSS > Newsfeed aktivieren

Aktivieren Sie diese option, wenn Sie ein Blog oder Newsfeed erstellen möchten. Ein Feed Icon

wird im Webbrowser angezeigt, dass ein Blog für diese Seite verfügbar ist. Mit einem Klick in

dieses Icon wird der RSS Feed geladen.
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3: Seite

Die Einträge des Feeds besteht aus allen Textfeldern der Seite. Wenn die Seite Unterseiten hat,

werden auch alle Textfelder der Unterseiten hinzugefügt. Um zu verhindern, dass ein Textfeld in

das Feed übernommen wird, deaktivieren Sie RSS > Text zum Feed hinzufügen in den

Eigenschaften des Textfelds.

INFO: Sie können nur ein Feed pro Seite erstellen. Wenn Sie auf einer Unterseite sind und

die Elternseite hat bereits ein Feed, können Sie kein Feed auf dieser Seite erstellen.

RSS > Feed Beschreibung

Geben Sie eine kurze Beschreibung für Ihren Newsfeed ein.
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4. Seitenvorlage
Lernen Sie wie Sie Seitenvorlagen verwenden. Legen Sie den hauptsächlich verwendeten

Hintergrund für alle Seiten Ihrer Website fest.

Jede Website besitzt ein einheitliches Layout und einen einheitlichen Stil. Sie können

Seitenvorlagen erstellen um das hauptsächlich verwendete Layout zu speichern. Wenden Sie die

Seitenvorlage auf allen Seiten Ihrer Website an, so dass sie alle das selbe Layout besitzen.

Wenn Sie das Layout nachträglich in der Seitenvorlage ändern, werden die Änderungen

auromatisch auf alle Seiten Ihrer Website angewendet.

Alle Seitenvorlagen Ihres Projekts werden unter Seitenvorlagen in der Projektliste auf der linken

Seite des Projektfensters aufgelistet.

 Klick und Seitenvorlage hinzufügen. Eine neue Seitenvorlage wird erstellt.

 Dupliziert eine gewählte Seitenvorlage.

 Löscht eine gewählte Seitenvorlage.

Die Seitenvorlage hat die selben Eigenschaften wie eine Seite (aber nur diese Eigenschaften, die

den Stil und das Layout festlegen).
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4: Seitenvorlage

Um eine Seitenvorlage auf einer Seite anzuwenden, wählen Sie die Seite in der Projektliste aus

und sehen Sie sich die Eigenschaften an. Wählen Sie die gewünschte Seitenvorlage bei Seite >

Seitenvorlage. Alle Eigenschaften, die den Stil und das Layout betreffen verschwinden. Sie

werden jetzt von der Seitenvorlage kontrolliert.

Eigenschaften für Seitenvorlage
Diese Eigenschaften können für eine Seitenvorlage eingestellt werden. Wählen Sie eine

Seitenvorlage um ihre Eigeschaften zu sehen.

Seitenvorlage > Seitenbreite (min)

Setzt die minimale Breite der Seite (Pixel). Wenn das Browserfenster kleiner ist, werden

Scrollbalken angezeigt. Die Breite eines Seitenbereichs muss kleiner oder die selbe wie die

Seitenbreite sein. Sie können keine minimale Seitenhöhe einstellen, weil die Höhe durch die

minimale Höhe von allen Seitenbereichen festgelegt wird.

Seitenvorlage > Position des Inhalts

Wählen Sie die Positionierung des Inhalts, wenn das Browserfenster größer als Seitenbreite (min)

ist.

Seitenvorlage > Seitenrand links

Setzt den Abstand von der linken Seite zum Seiteninhalt.

Seitenvorlage > Seitenrand rechts

Setzt den Abstand von der rechten Seite zum Seiteninhalt.

Seitenvorlage > Seitenrand oben

Setzt den Abstand von der oberen Seite zum Seiteninhalt.

Seitenvorlage > Seitenrand unten

Setzt den Abstand von der unteren Seite zum Seiteninhalt.

Seitenvorlage > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für die Seite.

Seitenvorlage > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Seitenvorlage > Hintergrundbild

Wählen Sie ein Hintergrundbild für die Seite. Mit Wiederholen können Sie einstellen wie das Bild

angezeigt werden soll.
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4: Seitenvorlage

Seitenvorlage > HTML Ausgabe deaktivieren PRO

Erzeugt eine Seite ohne jeglichen Inhalt oder HTML Code. Verwenden Sie diese Option nur,

wenn Sie ein Script schreiben möchten, das die HTML Codeausgabe übernimmt.

Seitenvorlage > Code vor dem Dokument hinzufügen PRO

Fügen Sie Code hinzu, bevor das HTML Dokument beginnt. Das wird von machen Scripts

gebraucht (z.B. wenn Sie Sessions in PHP verwenden möchten).

Seitenvorlage > Header HTML Code hinzufügen PRO

Fügt ihrer Seite eigenen HTML Code im Headbereich hinzu um die Funktionalität von Goldfish zu

erweitern.

Seitenvorlage > HTML Code hinzufügen PRO

Fügt Ihrer Seite eigenen HTML Code im Bodybereich hinzu um die Funktionalität von Goldfish zu

erweitern.

Seitenvorlage > Stylesheets hinzufügen PRO

Fügt Ihrer Seite eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.
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5. Seitenbereich
Teilen Sie die Seiten Ihrer Website in Bereiche auf. Z.B. ein Bereich für den Kopf, die

Navigation, den Fuß und den Inhalt.

Es gibt verschiedene Seitenbereiche (z.B. für den Kopf, den Fuß, die Navigation und den Inhalt)

auf jeder Seite Ihrer Website.

Jeder Seitenbereich (gelb) enthält den Inhalt Ihrer Website wie Menüs, Bilder und Text. Um zu

verstehen wie das Goldfish Seitenmodell funktioniert, lesen Sie die Dokumentation für das

Projekt.

Normalerweise ist mehr als ein Seitenbereich auf einer Seite. Sie können eine feste Breite und

eine minimale Höhe für jeden Seitenbereich festlegen. Die tatsächliche Höhe eines

Seitenbereichs hängt von dessen Inhalt und der Höhe der anderen Seitenbereiche in der Zeile

ab.

Um Seitenbereiche zu einer Seite hinzuzufügen, wählen Sie die Seite aus und ziehen Sie einen

Seitenbereich von den Komponenten in den Editor.

 Löscht den ausgewählen Seitenbereich.
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Wenn Sie Seitenbereiche hinzufügen, wird die Seite zeilenweise gefüllt von oben nach unten. Es

passen so viele Seitenbereiche in eine Zeile, solang ihre Breite kleiner wie die Breite der Seite ist.

Wenn die Zeile voll ist, wird der Seitenbereich in der nächsten Zeile dargestellt.

INFO: Die Höhe von allen Seitenbereichen ist in einer Zeile immer die Selbe. Es wird immer

die Höhe des größten Seitenbereichs gewählt.

Eigenschaften für Seitenbereich
Diese Eigenschaften können für einen Seitenbereich eingestellt werden. Wählen Sie einen

Seitenbereich um seine Eigenschaften zu sehen.

Seitenbereich > Bereichsvorlage

Wählen Sie eine Bereichsvorlagen, wenn Sie das Layout des Seitenbereichs mit einer Vorlage

überschreiben wollen. Beachten Sie, dass alle Eigenschaften die das Layout betreffen

ausgeblendet werden wenn eine Bereichsvorlage ausgewählt haben weil das Layout dann von

der Vorlage kontroliert wird.

Seitenbereich > Breite

Legt die Breite des Seitenbereichs (Pixel) fest. Die Breite eines Seitenbereichs muss kleiner oder

die selbe wie die Seitenbreite.

Seitenbereich > Höhe (min)

Legt die minimale Höhe des Seitenbereichs (Pixel) fest. Die tatsächliche Höhe wird durch die

Höhe des Inhalts und die Höhe der anderen Seitenbereiche in der selben Zeile berechnet.

Seitenbereich > Außenabstand links

Legt den Abstand zwischen der linken Seite der Bereichsvorlage vom Inhalt.

Seitenbereich > Außenabstand rechts

Legt den Abstand zwischen der rechten Seite der Bereichsvorlage vom Inhalt.

Seitenbereich > Außenabstand oben

Legt den Abstand zwischen der oberen Seite der Bereichsvorlage vom Inhalt.

Seitenbereich > Außenabstand unten

Legt den Abstand zwischen der unteren Seite der Bereichsvorlage vom Inhalt.

Seitenbereich > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für den Seitenbereich.

Seitenbereich > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.
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Seitenbereich > Hintergrundbild

Wählen Sie ein Hintergrundbild für den Seitenbereich. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

Seitenbereich > Breite linker Rand

Zeigt einen Rand auf der linken Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Seitenbereich > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Seitenbereich > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Seitenbereich > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Seitenbereich > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Seitenbereich > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Seitenbereich > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Seitenbereich > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Seitenbereich > HTML Code hinzufügen PRO

Fügt dem Seitenbereich eigenen HTML Code hinzu um die Funktionalität von Goldfish zu

erweitern.

Seitenbereich > Stylesheets hinzufügen PRO

Fügt dem Seitenbereich eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Inhalt > Inhalt bearbeiten

Bearbeiten Sie den Inhalt des Seitenbereichs und fügen Sie Ihrer Website Bilder, Texte oder

anderen Inhalt hinzu.
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6. Bereichsvorlage
Lernen Sie wie Sie Bereichsvorlagen verwenden. Entwerfen Sie das hauptsächlich von den

Seiten genutzte Layout Ihrer Website.

Auf jeder Seite Ihrer Website gibt es verschiedene Seitenbereiche (z.B. Kopf, Fuß, Navigation

und Inhalt). Manche von diesen Bereichen sind auf jeder Seite die selben (z.B. Navigation, Fuß,

Kopf). Verwenden Sie Bereichsvorlagen für diese Bereiche und zeigen Sie sie auf jeder Seite an.

Alle Bereichsvorlagen Ihres Projekts sind unter Bereichsvorlage in der Projektliste auf der linken

Seite des Projektfensters aufgelistet.

 Klick und Bereichsvorlage hinzufügen. Das fügt eine neue Bereichsvorlage hinzu.

 Dupliziert eine ausgewählte Bereichsvorlage.

 Löscht eine ausgewählte Bereichsvorlage.

Die Bereichsvorlage hat die selben Eigenschaften wie ein Seitenbereich (aber nur die

Eigenschaften, die den Stil und das Layout betreffen).

Um eine Bereichsvorlage auf einen Seitenbereich anzuwenden, wählen Sie den Seitenbereich
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aus und sehen Sie in die Eigenschaften. Wählen Sie Ihre Bereichsvorlage bei  Seitenbereich >

Bereichsvorlage aus. Alle Eigenschaften, die den Stil und das Layout betreffen werdena

usgeblendet. Sie werden jetzt von der Bereichsvorlage kontrolliert.

Eigenschaften für Bereichsvorlage
Diese Eigenschaften können für eine Bereichsvorlage eingestellt werden. Wählen Sie eine

Bereichsvorlage um ihre Eigeschaften zu sehen.

Bereichsvorlage > Bereichsvorlage

Wählen Sie eine Bereichsvorlagen, wenn Sie das Layout des Seitenbereichs mit einer Vorlage

überschreiben wollen. Beachten Sie, dass alle Eigenschaften die das Layout betreffen

ausgeblendet werden wenn eine Bereichsvorlage ausgewählt haben weil das Layout dann von

der Vorlage kontroliert wird.

Bereichsvorlage > Breite

Legt die Breite des Seitenbereichs (Pixel) fest. Die Breite eines Seitenbereichs muss kleiner oder

die selbe wie die Seitenbreite.

Bereichsvorlage > Höhe (min)

Legt die minimale Höhe des Seitenbereichs (Pixel) fest. Die tatsächliche Höhe wird durch die

Höhe des Inhalts und die Höhe der anderen Seitenbereiche in der selben Zeile berechnet.

Bereichsvorlage > Außenabstand links

Legt den Abstand zwischen der linken Seite der Bereichsvorlage vom Inhalt.

Bereichsvorlage > Außenabstand rechts

Legt den Abstand zwischen der rechten Seite der Bereichsvorlage vom Inhalt.

Bereichsvorlage > Außenabstand oben

Legt den Abstand zwischen der oberen Seite der Bereichsvorlage vom Inhalt.

Bereichsvorlage > Außenabstand unten

Legt den Abstand zwischen der unteren Seite der Bereichsvorlage vom Inhalt.

Bereichsvorlage > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für den Seitenbereich.

Bereichsvorlage > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.
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Bereichsvorlage > Hintergrundbild

Wählen Sie ein Hintergrundbild für den Seitenbereich. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

Bereichsvorlage > Breite linker Rand

Zeigt einen Rand auf der linken Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Bereichsvorlage > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Bereichsvorlage > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Bereichsvorlage > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Bereichsvorlage > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Bereichsvorlage > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Bereichsvorlage > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von den Seitenbereich in der eingegebenen Breite (Pixel).

Bereichsvorlage > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Bereichsvorlage > HTML Code hinzufügen PRO

Fügt dem Seitenbereich eigenen HTML Code hinzu um die Funktionalität von Goldfish zu

erweitern.

Bereichsvorlage > Stylesheets hinzufügen PRO

Fügt dem Seitenbereich eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.
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7. Text
Füllen Sie Ihre Website mit Inhalt und fügen Sie Text hinzu.

Sie können ein Textfeld zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen. Um ein

Textfeld hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder einer Seitenvorlage

und ziehen Sie das Textfeld von den Komponenten in den Editor.

Ein Textfeld zeigt Text an. Machen Sie einen Doppelklick darauf und SIe können den Text

bearbeiten. Im Texteditierungsmodus verändern sich die Eigenschaften. Wählen Sie Text aus

und klicken Sie auf Text bearbeiten > Schriftstil > Wählen... um den Schriftstil, die Ausrichtung

und die Größe zu ändern.

Der Schriftstil wird von der ausgewählten Schriftvorlage bestimmt. Aktivieren Sie eine Checkbox

um eine Stileigenschaft mit einem anderen Stil zu überschreiben.

INFO: Wenn Sie hauptsächlich den gleichen Stil auf jeder Seite und in jedem Textfeld

verwenden ist es besser die Standardschriftvorlage anstatt deren Stil in jedem Textfeld zu

überschreiben. Wählen Sie nichts aus (die Projekteigenschaften werden angezeigt) und

klicken Sie auf Projekt > Schriftvorlagen > Wählen....
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Ein anderes wichtiges Feature auf einer Website ist es Links hinzuzufügen. Wählen Sie Text aus

und aktivieren Sie Text bearbeiten > Als Link verwenden in den Eigenschaften. Klicken Sie in 

Wählen... um das Linkziel festzulegen.

Es ist wichtig die semantische Bedeutung Ihres Textes festzulegen. Suchmaschinen wie Google

bewerten Überschriften anders als normalen Text. Wählen Sie den texttyp bei Text bearbeiten

>Texttyp.

 - Überschrift 1. Ordnung - Überschrift 6. Ordnung: Der ausgewählte Text ist eine Überschrift.

Das legt nicht den Stil fest. Diese Eigenschaft ist wichtig für Suchmaschinen.
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 - Liste: Der ausgewählte Text ist Teil einer Liste. Jede neue Zeile ist ein separater Listenpunkt.

Ein Aufzählungszeichen kann vor jedem Listenpukt angezeigt werden.

Vielleicht möchten Sie ungewöhnliche Schriftarten für Überschriften und anderen Text

verwenden. Normalerweise ist das auf einer Website nicht möglich, weil die Schrift auf dem

Computer des Seitenbesuchers installiert sein muss.  Wenn Sie ungewöhnliche Schriftarten

verwenden werden sie vermutlich nicht richtig dargestellt.

Wenn Sie ungewöhnliche Schriftarten verwenden, aktivieren Sie Text > als Bild rendern in den

Eigenschaften. Goldfish erzeugt dann ein Bild mit dem Text in der ausgewählten Schriftart. Es

kann auf allen Computern angezeigt werden auch wenn die Schriftart dort fehlt.

INFO: Es wird nicht empfohlen diese Option für lange Texte zu verwenden. Verwenden sie

diese nur für Überschriften. Anderenfalls wird der Speicherplatzbedarf Ihrer Website

rapide ansteigen.

Eigenschaften für Text
Diese Eigenschaften können für ein Textfeld eingestellt werden. Wählen Sie ein Textfeld um

seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.
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Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

- 32 -

http://www.fishbeam.com/de/goldfish/clips.php


7: Text

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Text > Als Bild speichern

Rendert den Text als Bild, so dass Sie ungewöhnliche Schriftarten verwenden können.

Text > Inhalt bearbeiten

Startet den Editiermodus für ein Textfeld.

Linkstil > Schriftstil

Legt den Schriftstil für Links fest.

Visuelle Effekte
Sie können einen visuellen Effekt festlegen wenn der Benutzer mit einem Link interagiert (z.B. die

Farbe wechseln wenn der Besucher seinen Mauszeiger über den Link bewegt). Die folgenden

Eigenschaften sind die selben für Effekt beim Überfahren mit der Maus, Effekt beim Anklicken

und Effekt für schon besuchte Links.

Effekt > Schrift ändern

Ändert den Schriftstil eines Links.
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Effekt > Schriftart

Legt den Schriftstil fest, zu dem geändert werden soll.

RSS
Die folgenden Eigenschaften sind nur verfügbar wenn die Seite einen Newsfeed besitzt.

RSS > Text zum Feed hinzufügen

Fügt das Textfeld zum Newsfeed der Seite hinzu.

RSS > Titel des Eintrags

Der Titel des Newsfeedeintrags.

RSS > Datum

Das Datum, wann der Eintrag veröffentlicht wurde.

Eigenschaften für Text bearbeiten
Diese Eigenschaften können im Editiermodus eines Textfels festgelegt werden. Wählen Sie ein

Textfeld aus und machen Sie einen Doppelklick darauf um den Editiermodus zu beginnen.

Text bearbeiten > Texttyp

Legt die semantische Bedeutung für ausgewählten Text fest (normaler Text, Überschrift oder

Liste).

Text bearbeiten > Abstand links

Der ausgewählte Text gehört zu einer Liste. Legt den Abstand zwischen dem Listenpunkt und

dem Text fest.

Text bearbeiten > Aufzählungsbild

Wählen Sie ein Bild für das Aufzählungszeichen der Liste (nur bei Texttyp > Liste mit

Aufzählungsbild.

Text bearbeiten > Schriftstil

Sets the font style for selected text.

Text bearbeiten > Als Link verwenden

Definiert den ausgewählten Text als Link z.B. zu einer anderen Website.
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8. Bild
Bilder sind sehr wichtig für das Design Ihrer Website. Die Bildkomponente in Goldfish hat

schlaue Funktionen um Bilder zu bearbeiten und anzuzeigen.

Sie können ein Bild zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen. Um ein Bild

hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder einer Seitenvorlage und

ziehen Sie das Bild von den Komponenten in den Editor.

Ein Bildobjekt zeigt ein Bild auf Ihrer Website an. Neue Bildobjekte sind nocht leer. Ein

Fragezeichenicon  wird angezeigt. Um das Objekt mit einem Bild zu füllen, klicken Sie auf Bild >

Bild in den Eigenschaften und wählen Sie ein Bild von Ihrer Festplatte aus.

Das Medienimportfenster wird angezeigt. Hier können Sie eine Beschreibung eingeben (die

Beschreibung wird als alt Text im HTML Code verwendet). Sie können das Bild auch verkleinern

(empfohlen für große Bilder, die direkt von einer digitalen Kamera kommen), drehen oder

spiegeln.
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In Goldfish können Sie den Bildausschnitt verändern. Starten Sie den Editiermodus mit einem

Doppelklick auf das Bild. Jetzt können Sie mit dem Slider in das Bild hinzeinzoomen und den

angezeigten Bildausschnitt herumschieben.

INFO: Das ist nur möglich, wenn Bild > Beim Export neu berechnen in den Eigenschaften

aktiviert ist.

Achtung bei transparenten GIF Bildern oder GIF Animationen: Deaktivieren Sie immer Bild >

Beim Export neu berechnen. Anderenfalls wird das Bild nicht korrekt exportiert und die Animation

wird zerstört.
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Eigenschaften für Bild
Diese Eigenschaften können für ein Bild eingestellt werden. Wählen Sie ein Bild um seine

Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Bild > Bild

Wählen Sie das Bild aus, das angezeigt werden soll.

Bild > Beim Export neu berechnen

Berechnet eine optimierte Version des Bildes in der richtigen Größe und Qualität für Ihre Website.

Deaktivieren SIe dieses für transparente GIF Bilder und GIF Animationen.

Bild > Inhalt bearbeiten

Klicken Sie hier um den Bildausschnitt zu verändern. Beachten Sie: Diese Option ist nur

verfügbar, wenn Bild > Beim Export neu berechnen aktiviert ist.

- 38 -



8: Bild

Bild > Reflektion

Fügt dem Bild eine Reflektion hinzu. Geben Sie die Größe in Pixel an. Beachten Sie: Diese

Option ist nur verfügbar, wenn Bild > Beim Export neu berechnen aktiviert ist.

Bild > Horizontal spiegeln

Spiegelt das Bild horizontal. Beachten Sie: Diese Option ist nur verfügbar, wenn Bild > Beim

Export neu berechnen aktiviert ist.

Bild > Vertikal spiegeln

Spiegelt das Bild vertikal. Beachten Sie: Diese Option ist nur verfügbar, wenn Bild > Beim Export

neu berechnen aktiviert ist.

Bild > Drehen (Grad im Uhrzeigersinn)

Dreht das Bild im Uhrzeigersinn um den angegebenen Wert in Grad. NBeachten Sie: Diese

Option ist nur verfügbar, wenn Bild > Beim Export neu berechnen aktiviert ist.

Bild > Schatten

Fügt dem Bild einen Schatteneffekt hinzu. Wählen Sie eine Farbe für den Schatten. Beachten

Sie: Diese Option ist nur verfügbar, wenn Bild > Beim Export neu berechnen aktiviert ist.

Bild > Winkel

Der Winkel in Grad, in welche der Schatten zeigen soll.

Bild > Abstand

Der Abstand zwischen dem Bild und dem Schatten. Ein Wert von 0 legt fest, dass der Schatten

direkt unter dem Bild angezeigt wird.

Bild > Weichzeichnen

Geben Sie einen Wert ein um den Schatten weichzuzeichnen. Ein höherer Wert zeichnet den

Schatten stärker weich.

Bild > Deckkraft

Die Deckkraft des Schattens. 100 legt fest, dass der Schatten nicht transparent ist.

Link > Als Link verwenden

Verwendet das Bild als Link. Wählen Sie eine Seite aus, wohin der Link führen soll.

Visuelle Effekte
Sie können einen visuellen Effekt festlegen wenn der Benutzer mit dem Bildlink interagiert (z.B.

die Farbe wechseln wenn der Besucher seinen Mauszeiger über den Link bewegt). Die folgenden

Eigenschaften sind die selben für Effekt beim Überfahren mit der Maus und Effekt beim

Anklicken.
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Effekt > Bild ändern

Ändert das Bild. Wählen Sie ein Bild aus, auf das geändert werden soll.
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9. Multimedia
Fügen Sie Ihrer Website QuickTime, Flash, RealMedia und Windows Media Dateien hinzu.

Sie können einen Player für Multimediadateien zu jedem Seitenbereich und jeder

Bereichsvorlage hinzufügen. Um einen Player hinzuzufügen, bearbeiten Sie den Inhalt eines

Seitenbereichs oder einer Seitenvorlage und ziehen Sie das Multimediaobjekt von den

Komponenten in den Editor.

Ein Medienplayer spielt Multimediainhalte in vielen verschiedenen Formaten. Fügen Sie

QuickTime, Windows Media oder RealMedia kompatible Videos und Audiodateien oder

Flashfilme zu Ihrer Website hinzu.

INFO: Flash Video (.flv Dateien) werden nicht unterstützt. Es ist notwendig diese Dateien in

einen normalen Flash Film (.swf Datei) einzubetten. Sie können dann die .swf Datei in

einem Flashplayer anzeigen.

Wählen Sie den Player in den Eigenschaften bei Multimedia > Abspielsoftware, den Sie

verwenden wollen und wählen Sie bei Multimedia > Multimediadatei eine Multimediadatei von

Ihrer Festplatte. Jede Abspielsoftware besitzt eine Anzahl von spezifischen Eigenschaften.
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Eigenschaften für Multimedia
Diese Eigenschaften können für ein Multimediaobjekt eingestellt werden. Wählen Sie ein

Multimediaobjekt um seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.
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Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.
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Multimedia > Multimediadatei

Wählen Sie die Multimediadatei von Ihrer Festplatte aus, die Sie anzeigen möchten.

Multimedia > Abspielsoftware

Wählen Sie den Typ der Abspielsoftware, die die Multimediadatei abspielen kann.

Multimedia > Abspielen automatisch starten

Spielt die Multimediadatei automatisch ab, nachdem die Seite geladen wurde.

Multimedia > Endlosschleife

Spielt die Multimediadatei in einer Endlosschleife ab.

Multimedia > Bedienelemente anzeigen

Zeigt Steuerelemente wie Abspielen, Stopp und Pause (nur QuickTime, RealPlayer, Windows

Media).

Multimedia > Menü zum Sichern der Mediendatei verstecken

Blendet das Menü aus, mit dem die Multimediadatei gespeichert werden kann (nur Quicktime).

Multimedia > Transparenter Hintergrund

Zeigt Flashfilme mit Alphakanal und Transparent vor dem Seiteninhalt an (nur Flash).
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10. Navigationsmenü
Fügen Sie ein Navigationsmenü zu Ihrer Website hinzu. Ein Navigationsmenü ist das

wichtigste Element, das Seitenbesucher verwenden um auf Ihrer Website zu navigieren.

Sie können ein Navigationsmenü zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen.

Um ein Navigationsmenü hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder

einer Seitenvorlage und ziehen Sie das Navigationsmenü von den Komponenten in den Editor.

Normalerweise sollten Sie ein Navigationsmenü zu einer Bereichsvorlage hinzufügen und diese

Bereichsvorlage auf jeder Seite Ihrer Website verwenden. Dadurch wird das Navigationsmenü

auf jeder Seite von Ihrer Website an der selben Stelle angezeigt.

Das Navigationsmenü zeigt automatisch die Seiten Ihrer Website als Menüeinträge an.

Normalerweise enthält es genau einen Eintrag für jede Seite Ihrer Website. Der angezigte Text ist

immer die Seite > Menütitel-Eigenschaft einer Seite.

Um den Text zu ändern, wählen Sie die betreffende Seite und bearbeiten Sie die Seite >
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Menütitel-Eigenschaft der Seite. Wenn Sie Seite > Menütitel deaktivieren, taucht die Seite nicht

im Navigationsmenü auf.

INFO: Es ist nicht möglich einen Link manuell zu einem Navigationsmenü hinzuzufügen.

Das Navigationsmenü zeigt immer automatisch die Seiten Ihrer Website.

Es gibt mehrere Typen von Navigationsmenüs. Sie können den Typ in den Eigenschaften bei 

Menü > Menütyp einstellen.

 - Einfaches Menü (1): Zeigt nur eine Hierarchieebene der Seiten an. Es zeigt keine

Untermenüs. Wenn Ihre Website Seiten mit unterseiten enthält, benötigen Sie ein zweites

Navigationsmenü dafür.

 - Menü mit Untermenü (2): Zeigt nur zwei Hierarchieebenen der Seiten an. Es zeigt ein

Submenü. Wenn Sie auf eine Seite mit Unterseiten klicken, erscheint das Untermenü direkt

unter dem Hauptmenüeintrag der Seite.

 - Dropdownmenü rechts (3): Zeigt alle Hierarchieebenen der Seiten in einer Menüstruktur.

Wenn der Besucher Ihrer Website die Maus über einen Menüeintrag von einer Seite mit

Unterseiten bewegt, geht ein Untermenü auf.

 - Dropdownmenü unten (4): Zeigt alle Hierarchieebenen der Seiten in einer Menüstruktur.

Wenn der Besucher Ihrer Website die Maus über einen Menüeintrag von einer Seite mit

Unterseiten bewegt, geht ein Untermenü auf.
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By default, the main menu shows the first hierarchy level of pages (the start page and their sub

pages are shown). If you want to create a navigation menu that shows pages from another level,

change the property Menu > Base Folder. Here are all pages listed, that have sub pages. E.g. if

you select products in this example, products and all it's sub pages are shown.

INFO: If you change the size of the menu item, so that there is enough space, the menu

entries are displayed side by side.

Eigenschaften für Navigationsmenü
Diese Eigenschaften können für ein Navigationsmenü eingestellt werden. Wählen Sie ein

Navigationsmenü um seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Menü > Basisordner

Wählen Sie eine Seite mit Unterseiten, die als Hauptmenüeinträge angezeigt werden.

Voreingestellt ist die Startseite, aber Sie können diese Eigenschaft verändern um Untermenüs zu

erzeugen.

Menü > Basisordner als Meüeintrag zeigen.

Zeigt die ausgewählte Seite von Menü > Basisordner im Hauptmenü an. Wenn Sie diese

Eigenschaft deaktivieren werden nur ihre Unterseiten angezeigt.

Menü > Elterneintrag hervorheben

Wenn Sie sich auf einer Seite aus dem Untermenü befinden, wird auch der Eintrag der

übergeordneten Seite hervorgehoben. Wenn Sie diese Eigenschaft deaktivieren, wird nur der

Eintrag der aktuellen Seite hervorgehoben.

Menü > Menütyp

Legt den Menütyp für das Menü fest. Sie können wählen zwischen:

 - Einfaches Menü

 - Menü mit Untermenü

 - Dropdownmenü rechts

 - Dropdownmenü unten

Menü > Zwischenraum horizontal

Legt den Abstand zwischen dem unteren Rand eines Menüeintrags und dem oberen Rand des

nächsten Menüeintrags fest.
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Menü > Zwischenraum vertikal

Legt den Abstand zwischen dem rechten Rand eines Menüeintrags und dem linken Rand des

nächsten Menüeintrags fest.

Eintrag Hauptmenü und Eintrag Untermenü
Die folgenden Eigenschaften sind die selben für Eintrag Hauptmenü und Eintrag Untermenü.

Beachten Sie, dass Eintrag Untermenü nur sichtbar ist, wenn Sie nicht Einfaches Menü bei Menü

> Menütyp auswählen, weil ein einfaches Menü kein Untermenü besitzt.

Menüeintrag > Breite

Legt die Breite eines Menüeintrags in Pixel fest.

Menüeintrag > Höhe

Legt die Höhe eines Menüeintrags in Pixel fest.

Menüeintrag > Positionierung

Legt die Textausrichtung in einem Menüeintrag fest.

Menüeintrag > Schriftstil

Legt den Schriftstil in einem Menüeintrag fest.

Menüeintrag > Innenabstand links

Legt den Abstand von der linken Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Menüeintrag > Innenabstand rechts

Legt den Abstand von der rechten Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Menüeintrag > Innenabstand oben

Legt den Abstand von der oberen Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Menüeintrag > Innenabstand unten

Legt den Abstand von der unteren Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Menüeintrag > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für einen Menüeintrag.

Menüeintrag > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Menüeintrag > Hintergrundbild

Wählen Sie ein Hintergrundbild für einen Menüeintrag. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.
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Menüeintrag > Breite linker Rand

Zeigt einen Rand auf der linken Seite von einem Menüeintrag in der eingegebenen Breite (Pixel).

Menüeintrag > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Menüeintrag > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von einem Menüeintrag in der eingegebenen Breite

(Pixel).

Menüeintrag > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Menüeintrag > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von einem Menüeintrag in der eingegebenen Breite (Pixel).

Menüeintrag > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Menüeintrag > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von einem Menüeintrag in der eingegebenen Breite

(Pixel).

Menüeintrag > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Visuelle Effekte
Sie können einen visuellen Effekt festlegen wenn der Benutzer mit dem Navigationsmenü

interagiert (z.B. die Farbe wechseln wenn der Besucher seinen Mauszeiger über einen Eintrag

bewegt). Die folgenden Eigenschaften sind die selben für Effekt beim Überfahren mit der Maus, 

Effekt beim Anklicken und Effekt für schon besuchte Links.

Effekt > Schrift ändern

Ändert den Schriftstil von einem Menüeintrag.

Effekt > Schriftstil

Legt den Schriftstil fest, auf den geändert werden soll.

Effekt > Hintergrund ändern

Ändert den Hintergrund von einem Menüeintrag.

Effekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für einen Menüeintrag.
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Effekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Effekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für einen Menüeintrag. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

Effekt > Rand ändern

Ändert den Rand von einem Menüentrag.

Effekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von einem Menüeintrag in der eingegebenen Breite (Pixel).

Effekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Effekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von einem Menüeintrag in der eingegebenen Breite

(Pixel).

Effekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Effekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von einem Menüeintrag in der eingegebenen Breite (Pixel).

Effekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Effekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von einem Menüeintrag in der eingegebenen Breite

(Pixel).

Effekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Effekt > Innenabstand ändern

Ändert den Innenabstand von einem Menüeintrag.

Effekt > Innenabstand links

Legt den Abstand von der linken Seite von einem Menüeintrag zum Inhalt in Pixel fest.
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Effekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Effekt > Innenabstand oben

Legt den Abstand von der oberen Seite von einem Menüeintrag zum Inhalt in Pixel fest.

Effekt > Innenabstand unten

Legt den Abstand von der unteren Seite von einem Menüeintrag zum Inhalt in Pixel fest.
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Mit Formen können Sie Rechtecke, abgerundete Rechtecke, Ovale und Linien direkt auf

Ihrer Website zeichnen.

Sie können eine Form zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen. Um eine

Form hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder einer Seitenvorlage und

ziehen Sie die Form von den Komponenten in den Editor.

Formen sind eine gute Wahl, wenn Sie das Layout Ihrer Website entwerfen möchten. Formen

können Rechtecke, abgerundete Rechtecke, Ovale oder Linien enthalten. Oder nichts, wenn Sie

nur ein Hintergrundbild oder eine Hintergrundfarbe in der Form anzeigen wollen.

Die Eigeschaft Form > Form anzeigen definiert ob eine Form im Objekt angezeigt wird und

welche Form verwendet wird. Wählen Sie zwischen Rechteck, abgerundetes Rechteck, Oval oder

Linie. Es hängt von Ihrer Auswahl ab welche anderen Optionen verfügbar sind.
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Jede Form hat eine Füllfarbe und einen Rand. Wenn Sie nur ein Rechteck mit einem Hintergrund

oder einer Farbe möchten, deaktivieren Sie Form > Form anzeigen und verwenden Sie

stattdessen den Hintergrund des Objekts.

Eigenschaften für Form
Diese Eigenschaften können für eine Form eingestellt werden. Wählen Sie eine Form um ihre

Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.
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Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Form > Form anzeigen

Wählen Sie die Form, die angezeigt werden soll. Deaktivieren Sie diese Option, wenn Sie keine

Form möchten.

Form > Bogen

Legt die Rundung für abgerundete Rechtecke fest.
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Form > Füllfarbe

Wählen Sie eine Füllfarbe für die Form oder die Farbe einer Linienform.

Form > Größe

Legt die Größe einer Linienform in Pixel fest.

Form > Randbreite

Legt die Breite für den Rand von der Form in Pixel fest.

Form > Randfarbe

Wählen Sie eine Farbe für den Rand der Form.
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Mit einer Galerie können Sie den Seitenbesuchern dutzende Fotos in einer Diashow

präsentieren.

Sie können eine Galerie zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen. Um eine

Galerie hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder einer Seitenvorlage

und ziehen Sie die Galerie von den Komponenten in den Editor.

Eine Galerie zeigt eine Auswahl von Bildern als Vorschaubilder. Der Besucher Ihrer Website kann

auf jedes Vorschaubild klicken um eine größere Version zu sehen. Optional können Sie eine

Diashow hinzufügen, so dass das nächste Bild automatisch geladen wird.

Um Bilder in Ihre Galerie einzufügen, machen Sie einen Doppelklick darauf um den Inhalt zu

Bearbeiten. Verändern Sie die Bildreihenfolge mit Drag und Drop oder Klicken Sie in den

Löschbutton eines Bildes um es zu löschen. In den Eigenschaften sind verschiedene

Möglichkeiten:

Galerie bearbeiten > Ein Bild hinzufügen

Wählen Sie ein Bild von Ihrer Festplatte um es in die Galerie einzufügen.

Galerie bearbeiten > Aus Ordner hinzufügen

Wählen Sie ein Ordner mit Bildern von Ihrer Festplatte. Goldfish fügt alle diese Bilder in Ihre

Galerie ein.
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Galerie bearbeiten > Alle Bilder löschen

Löscht alle Bilder aus Ihrer Galerie.

Wenn Sie Bilder in Ihre Galerie einfügen, erscheint das Medienimportfenster für jedes Bild. Falls

Sie große Bilder haben (z.B. von einer Digitalkamera), sollten Sie die Größe auf höchstens 700 x

700 Pixel reduzieren. Wenn Sie möchten können Sie eine Beschreibung für jedes Bild

hinzufügen. Aktivieren Sie Für alle, wenn Sie nicht möchten dass das Medienimportfenster für

jedes Bild einzeln aufgeht.

Wenn ein Besucher Ihrer Website auf ein Vorschaubild klickt, wird die größere Version von

diesem Bild geladen. Es gibt verschiedene Anzeigetypen für die größere Version.
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Wählen Sie Animierte Galerie bei Präsentationsseite > Typ in den Eigenschaften und die Bilder

erscheinen im Vordergrund, während Ihre Website im Hintergrund abgedunkelt wird.
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Wählen Sie Bildzoom bei Präsentationsseite > Typ in den Eigenschaften und die Bilder

erscheinen im Vordergrund, während Ihre Website im Hintergrund bleibt.

Wählen Sie Klassisch bei Präsentationsseite > Typ in den Eigenschaften und die Bilder werden

auf einer separaten Seite geladen.

Wenn sie die Bilder automatisch in einer Diashow anzeigen möchten, aktivieren Sie 

Präsentationsseite > Diashow Geschwindigkeit (Sec) in den Eigenschaften und geben Sie eine

Zeit in Sekunden ein. Deaktivieren Sie andernfalls diese Option. Falls Sie die Kommentare, die

Sie im Medienimportfenster eingegeben haben unter jedem Bild anzeigen möchten, aktivieren Sie

Präsentationsseite > Bildbeschreibung anzeigen.
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Um einen Kommentar für ein Bild zu ändern, machen Sie einen Doppelklick auf die Galerie um

Sie zu bearbeiten und einen Rechtsklick (Control-Klick) auf ein Bild und wählen Sie Kommentar

bearbeiten....

Eigenschaften für Galerie
Diese Eigenschaften können für eine Galerie eingestellt werden. Wählen Sie eine Galerie um ihre

Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.
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Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Galerie > Inhalt bearbeiten

Klicken Sie hier, um den Inhalt der Galerie zu bearbeiten oder machen Sie einen Doppelklick

darauf.

Galerie > Titel

Der Titel Ihrer Galerie. Er wird auf der Präsentationsseite einer in der Titelzeile Ihres

Webbrowsers angezeigt (nur, wenn sie Klassich bei Präsentationsseite > Typ gewählt haben).

Vorschaubild > Icon Breite (max)

Legt die maximale Breite eines Vorschaubilds fest. Maximal weil die Proportionen beim

Verkleinern erhalten bleiben.

Vorschaubild > Icon Höhe (max)

Legt die maximale Höhe eines Vorschaubilds fest. Maximal weil die Proportionen beim

Verkleinern erhalten bleiben.

Vorschaubild > Zwischenraum horizontal

Legt den Abstand zwischen der Unterseite eines Vorschaubilds und der Oberseite des nächsten

Vorschaubilds fest.

Vorschaubild > Zwischenraum vertikal

Legt den Abstand zwischen der rechten Seite eines Vorschaubilds und der linken Seite des

nächsten Vorschaubilds fest.

Vorschaubild > Innenabstand links

Legt den Abstand von der linken Seite von einem Vorschaubild zum Inhalt in Pixel fest.

Vorschaubild > Innenabstand rechts

Legt den Abstand von der rechten Seite von einem Vorschaubild zum Inhalt in Pixel fest.

Vorschaubild > Innenabstand oben

Legt den Abstand von der oberen Seite von einem Vorschaubild zum Inhalt in Pixel fest.
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Vorschaubild > Innenabstand unten

Legt den Abstand von der unteren Seite von einem Vorschaubild zum Inhalt in Pixel fest.

Vorschaubild > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für ein Vorschaubild.

Vorschaubild > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Vorschaubild > Hintergrundbild

Wählen Sie ein Hintergrundbild für ein Vorschaubild. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

Vorschaubild > Breite linker Rand

Zeigt einen Rand auf der linken Seite von einem Vorschaubild in der eingegebenen Breite (Pixel).

Vorschaubild > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Vorschaubild > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von einem Vorschaubild in der eingegebenen Breite

(Pixel).

Vorschaubild > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Vorschaubild > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von einem Vorschaubild in der eingegebenen Breite

(Pixel).

Vorschaubild > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Vorschaubild > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von einem Vorschaubild in der eingegebenen Breite

(Pixel).

Vorschaubild > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

- 65 -

http://www.fishbeam.com/de/goldfish/clips.php


12: Galerie

Präsentationsseite > Typ

Wählen Sie den Typ der Galerie. Der Typ legt fest wie die größere Version der Bilder präsentiert

wird.

Präsentationsseite > Diashow Geschwindigkeit (Sec)

Legt fest wie lange ein Bild in einer Diashow angezeigt wird. Deaktivieren Sie diese Option für

keine Diashow.

Präsentationsseite > Bildbeschreibung anzeigen

Zeigt die Kommentare von einem Bild unter der größeren Version auf der Präsentationsseite an.

Präsentationsseite > Schriftstil

Legt den Schriftstil für die Präsentationsseite fest.

Präsentationsseite > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für die Präsentationsseite.

Präsentationsseite > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Präsentationsseite > Hintergrundbild

Wählen Sie ein Hintergrundbild für die Präsentationsseite. Mit Wiederholen können Sie einstellen

wie das Bild angezeigt werden soll.

Präsentationsseite > Deckkraft (%)

Legt die Deckkraft für den Hintergrund fest (nur Verfügbar für Animierte Galerie Als Typ.
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Fügen Sie Ihrer Website einen Besucherzähler hinzu. Mit einem Besucherzähler können

Sie die Anzahl der Besucher auf Ihrer Website anzeigen.

Sie können einen Besucherzähler zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen.

Um einen Besucherzähler hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder

einer Seitenvorlage und ziehen Sie den Besucherzähler von den Komponenten in den Editor.

Ein Besucherzähler zählt jeden Besucher Ihrer Website und zeigt die Anzahl der Besucher auf

einem Bild an. Wiederkehrende Besucher werden nur alle 24 Stunden gezählt. Ändern Sie die

Eigenschaften im Bereich Besucherzähler um den Stil des Zählers zu ändern.

Die Eigenschaft Besucherzähler > Stil legt den Stil des Zählers fest. Sie können aus vielen

verschiedenen Stilen in verschiedenen Farben wählen. Besucherzähler > Ziffern legt die Größe

des Zählers fest. Wenn der Zählerstand zu groß für die Anzahl der Ziffern ist, werden die letzten

Ziffern abgeschnitten.

INFO: Wenn Sie Goldfish Clips (http://www.fishbeam.com/de/goldfish/clips.php) installiert

haben sind viele weitere Stile verfügbar. Wenn nicht gibt es nur die sieben eingebauten
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Stile.

Falls Ihnen die eingebauten Stile nicht gefallen, können Sie ein eigenes Zählerbild erstellen. Das

Zählerbild ist ein kleines Bild mit den Ziffern 0 bis 9 darauf. Das Zählerscript schneidet jede Ziffer

aus, die gebraucht wird und baut sie zusammen um den Zählerstand anzuzeigen.

Wählen Sie Eigener Stil bei Besucherzähler > Stil in den Eigenschaften und wählen Sie ihr

erstelltes Zählerbild aus.

INFO: Dieses Objekt verwendet PHP. Ihr Webserver muss PHP unterstützen um es zu

nutzen.

Eigenschaften für Besucherzähler
Diese Eigenschaften können für einen Besucherzähler eingestellt werden. Wählen Sie einen

Besucherzähler um seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.
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Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Besucherzähler > Stil

Wählen Sie den Stil für Ihren Besucherzähler aus.

Besucherzähler > Zählerbild

Wählen Sie ein eigenes Zählerbild, wenn Sie einen eigenen Stil für Ihren Besucherzähler

verwenden möchten.

Besucherzähler > Ziffern

Legt die Anzahl der Ziffern fest, die der Zähler anzeigt.
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Fügen Sie ein Kontaktformular zu Ihrer Website hinzu. Mit diesem Formular können Ihnen

die Besucher Nachrichten senden.

Sie können ein Formular zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen. Um ein

Formular hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder einer Seitenvorlage

und ziehen Sie das Formular von den Komponenten in den Editor.

Ein Formular lässt die Besucher Ihrer Website mit Ihnen in Kontakt treten. Normalerweise füllt er

das Formular aus, sendet es ab und Sie erhalten eine E-Mail mit dem Inhalt des Formulars. Aber

Sie können auch manuelle Formulare erstellen, die mit Ihren Webanwendungen und Scripten

kommunizieren.

Machen Sie einen Doppelklick auf das Formular um seinen Inhalt zu bearbeiten. Sie können die

Reihenfolge der Formularelemente mit Drag und Drop verändern. Ein Klick in den Löschknopf

von einem Element um es aus dem Formular zu löschen. Ziehen Sie neue Formularelemente aus

den Komponenten in das Formular. Die folgenden Elemente sind verfügbar:

 - Textfeld: Zeigt ein einzeiliges Textfeld im Formular an. Das Element ist dazu geeignet kurze

Informationen wie Namen, E-Mail Adressen oder Passwörter einzugeben.

 - Mehrzeiliges Textfeld: Zeigt ein großes Textfeld im Formular an. Das Element ist dazu

geeignet lange Texte mit mehreren Zeilen einzugeben.

 - Auswahlelement: Zeigt eine Liste, ein Popupmenü oder Radiofelder an. Das Element ist dazu

geeignet den Besucher zwischen mehreren Optionen entscheiden zu lassen.

 - Checkbox: Zeigt eine Checkbox im Formular an. Das Element ist dazu geeignet eine Option

ein oder abzuwählen.
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Machen Sie einen Doppelklick auf ein Formularelement um seine Eigenschaften zu sehen.

Welche Eigenschaften verfügbar sind hängt davon ab auf welches Formularelement Sie geklickt

haben.

Eigenschaften für Textfeld

Name

Geben Sie einen Namen für das Formularelement ein. Das ist wichtig für manuelle Formulare.

Der Name muss eindeutig in einem Formular sein und kann nur Buchstaben, Zahlen, _ und -.

Anzeigename

Der Name der im Formular und der E-Mail mit dem Formularinhalt angezeigt wird.

Formelement muss ausgefüllt sein

Aktivieren Sie diese Option und der Besucher muss einen Wert in diesem Element eingeben.

Andernfalls kann das Formular nicht gesendet werden.

Voreingestellter Text

Das Textfeld ist standardmäßig mit diesem Text gefüllt.

Passwortfeld

Das Textfeld zeigt nur ******* wenn der Besucher Text eingibt. Das wird für Passwörter

verwendet.
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Nur E-Mail Adressen erlauben

Nur E-Mail Adressen können eingegeben werden. Sie können ein Formularelement als

Antwortadresse für E-Mailformulare auswählen.

Eigenschaften für Mehrzeiliges Textfeld

Name

Geben Sie einen Namen für das Formularelement ein. Das ist wichtig für manuelle Formulare.

Der Name muss eindeutig in einem Formular sein und kann nur Buchstaben, Zahlen, _ und -.

Anzeigename

Der Name der im Formular und der E-Mail mit dem Formularinhalt angezeigt wird.

Formelement muss ausgefüllt sein

Aktivieren Sie diese Option und der Besucher muss einen Wert in diesem Element eingeben.

Andernfalls kann das Formular nicht gesendet werden.

Voreingestellter Text

Das Textfeld ist standardmäßig mit diesem Text gefüllt.

Höhe (Pixel)

Die Höhe des Textfelds in Pixel. Wenn der Besucher mehr Text eingibt werden Scrollbalken

angezeigt.

Eigenschaften für Auswahlelement

Name

Geben Sie einen Namen für das Formularelement ein. Das ist wichtig für manuelle Formulare.

Der Name muss eindeutig in einem Formular sein und kann nur Buchstaben, Zahlen, _ und -.

Anzeigename

Der Name der im Formular und der E-Mail mit dem Formularinhalt angezeigt wird.

Formelement muss ausgefüllt sein

Aktivieren Sie diese Option und der Besucher muss einen Wert in diesem Element eingeben.

Andernfalls kann das Formular nicht gesendet werden.

Auswahlart

Legt die Art der Auswahl fest: Liste, Popupmenü or Radiofelder

Optionen

Fügen Sie Optionen hinzu oder löschen Sie welche, aus denen der Benutzer auswählen kann.

Jede Option hat einen Wert für den internen Gebrauch und einen Anzeigenamen, der in Emails

und im Formular angezeigt wird. Wenn Sie Ausgewählt aktivieren, ist die Option standardmäßig

ausgewählt.
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Höhe (Pixel)

Die Höhe der Liste (nur bei Listen).

Mehrfachauswahl

Der Benutzer kann mehrere Optionen gleichzeitig in der Liste auswählen (nur bei Listen).

Eigenschaften für Checkbox

Name

Geben Sie einen Namen für das Formularelement ein. Das ist wichtig für manuelle Formulare.

Der Name muss eindeutig in einem Formular sein und kann nur Buchstaben, Zahlen, _ und -.

Anzeigename

Der Name der im Formular und der E-Mail mit dem Formularinhalt angezeigt wird.

Formelement muss ausgefüllt sein

Aktivieren Sie diese Option und der Besucher muss einen Wert in diesem Element eingeben.

Andernfalls kann das Formular nicht gesendet werden.

Ausgewählt

Die Checkbox ist standardmäßig aktiviert.

Um das Formular an Ihre E-Mail Adresse zu senden, müssen Sie sie bei E-Mail > E-Mail

Addresse eingeben.
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Es ist möglich, dass Goldfish die eingegebene E-Mail Adresse des Besuchers als Antwortadresse

für die E-Mail, die Sie erhalten, festlegt. Dafür müssen Sie mindestens ein Textfeld als E-Mail

Adressfeld festlegen. Machen Sie einen Doppelklick auf ein Textfeld und aktivieren Sie Nur

E-Mail Adressen erlauben.

Verlassen Sie den Editiermodus des Formulars. Bei E-Mail > Antwort E-Mailadresse ist eine Liste

von allen E-Mail Textfeldern. Wählen Sie ein Textfeld als Antwort E-Mailadresse aus.

INFO: Dieses Objekt verwendet PHP. Ihr Webserver muss PHP unterstützen um es zu

nutzen.

Eigenschaften für Formular
Diese Eigenschaften können für ein Formular eingestellt werden. Wählen Sie ein Formular um

seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.
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Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Formular > Formulartyp

Legt den Typ des Formulars fest: E-Mailformular oder Manuelles Formular.

Formular > Internetadresse

Die Internetadresse zu welcher das Formular gesendet wird (nur bei manuellen Formularen). Bei

dieser Adresse muss ein Script hinterlegt sein, das die Formulardaten entgegen nimmt.

Formular > Sendemethode

Legt die Sendemethode fest Get or Post nur bei manuellen Formularen).

Formular > Zwischenraum horinzontal

Legt den Abstand zwischen zwei Formularelementen fest.

Formular > Schriftstil

Legt den Schriftstil für das Formular fest.
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Formular > Farbe für Fehler

Wählen Sie die Farbe aus, in der Fehler beim Absenden des Formulars angezeigt werden.

Formular > Sendebutton

Aktivieren Sie diese Eigenschaft um einen Sendebutton anzuzeigen. Geben Sie die Beschriftung

des Buttons ein.

Formular > Resetbutton

Aktivieren Sie diese Eigenschaft um einen Resetbutton anzuzeigen. Geben Sie die Beschriftung

des Buttons ein.

Formular > Inhalt bearbeiten

Klicken Sie hier um den Inhalt des Formulars zu bearbeiten.

E-Mail > E-Mailadresse

Legt die E-Mailadresse fest an die das Formular gesendet wird.

E-Mail > E-Mail Betreff

Legt den Betreff für die Formularemail fest.

E-Mail > Nachricht gesendet

Legt die Nachricht fest, die dem Besucher angezeigt wird wenn das Formular erfolgreich

gesendet wurde.

E-Mail > Antwort E-Mailadresse

Wählen Sie das E-Mail Textfeld aus, das die E-Mailadresse des Besuchers Ihrer Website enthält.
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15. Website Frame
Mit einem Website Frame können Sie eine externe Website direkt auf Ihrer Website

anzeigen.

Sie können einen Website Frame zu jedem Seitenbereich und jeder Bereichsvorlage hinzufügen.

Um einen Website Frame hinzuzufügen, bearbeiten Sie den Inhalt eines Seitenbereichs oder

einer Seitenvorlage und ziehen Sie den Website Frame von den Komponenten in den Editor.

Ein Website Frame zeigt eine externe Website direkt auf Ihrer Seite an. Zum Beispiel können Sie

ein Forum oder eine andere Webanwendung, die Goldfish nicht direkt unterstützt, einfügen.

Geben Sie die Url der externen Website bei Website Frame > Url des Frameinhalts.

Eigenschaften für Website Frame
Diese Eigenschaften können für einen Website Frame eingestellt werden. Wählen Sie einen

Website Frame um seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.
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Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.
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Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Website Frame > Url des Frameinhalts

Geben Sie die Url der externen Website ein, die Sie anzeigen möchten.

Website Frame > Scrollbalken zeigen falls benötigt

Aktivieren Sie diese Eigenschaft und es werden Scrollbalken angezeigt wenn die externe Website

größer ist als der Frame. Andernfalls wird der nicht gezeigte Inhalt abgeschnitten.
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Verwenden Sie einen HTML Code Container um Ihren eigenen HTML Code zu einer Seite

hinzuzufügen und erweitern Sie so die Funktionalität von Goldfish.

Sie können einen HTML Code Container zu jedem Seitenbereich und jeder Bereichsvorlage

hinzufügen. Um einen HTML Code Container hinzuzufügen, bearbeiten Sie den Inhalt eines

Seitenbereichs oder einer Seitenvorlage und ziehen Sie den HTML Code Container von den

Komponenten in den Editor.

Ein HTML Code Container zeigt jeden Schnipsel von HTML Code an, den Sie möchten. Zum

Beispiel können Sie eine Google Maps (http://www.google.de/maps) Karte auf Ihrer Website

anzeigen und so Ihren Besuchern zeigen wo Sie sind.

Geben Sie den HTML Code im Codeeditor ein. Um den Codeeditor zu öffnen, klicken Sie auf 

HTML Code > HTML Code in den Eigenschaften. Ein HTML Code Container ist die einzige

Möglichkeit in Goldfish Standard HTML Code zu hinterlegen. Wenn Sie mehr Möglichkeiten

brauchen um HTML oder CSS Code einzugeben, upgraden Sie bitte auf Goldfish Professional.
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Properties for HTML Code
These properties can be set for a html code container. Select a html code container to show its

properties.

Eigenschaften für HTML Code
Diese Eigenschaften können für einen HTML Code Container eingestellt werden. Wählen Sie

einen HTML Code Container um seine Eigeschaften zu sehen.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

HTML Code > HTML Code

Geben Sie den HTML Code ein, der eingefügt werden soll.
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17. Path
Show the path to the current page on your website to provide a clearer navigation.

You can add a path to every page area or area template. To add a path, edit the content of a

page area or area template and drag the path from the elements panel to the editor.

A path shows the path from the current website back to the start page. Every page of the path is a

link so that the visitors of your website can navigate to it.

Properties for Path
These properties can be set for a path. Select a path to show its properties.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.
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Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Path > Font Style

The font style for the delemiter.

Path > Delemiter

Delemiter between two links. The default value is >.

Link Style > Font Style

The font style for links.

Visual Effects
You can specify a visual effect, if your site visitor interacts with the path links (e.g. change the

color if your site visitor moves his mouse over the link). The following properties are the same for

Moving mouse over link effect, Clicking on link effect and Already visited link effect.   

Link Style > Change Font

Changes the font style of a menu item.

Link Style > Font Style

Sets the font style, to which will be changed.
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18. Comments and Guestbook
Add a comments field or a guestbook to your website and receive feedback from the

visitors of your website.

You can add a comments field to every page area or area template. To add a comments field,

edit the content of a page area or area template and drag the comments field from the elements

panel to the editor.

With a comment field the visitors of your website can leave short messages on your website (e.g.

for a blog entry). The same functionality is used by a guestbook. So you can use the comment

field for both: Comments and a guestbook.

You can decide if you want to allow visitors of your website to reply to comments. Enable 

Comments > Allow Replies in the properties to allow replies.  

Everyone can add commets to a comments item but deleting comments is protected by a

password. Click on the project  and enter a password at Project > Admin Password in the

properties. Then click  in the comments field at your website and enter the password. Now
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you can delete comments and send e-mails to comment writers.

INFO: Dieses Objekt verwendet PHP. Ihr Webserver muss PHP unterstützen um es zu

nutzen.

Properties for Comments
These properties can be set for a comments field. Select a comments field to show its properties.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.
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Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.
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Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Comments > Allow Replies

Allows the visitors of your website to reply to comments.

User Interface > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für the comments field.

User Interface > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

User Interface > Hintergrundbild

Wählen Sie ein Hintergrundbild für the comments field. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

User Interface > Innenabstand links

Legt den Abstand von der linken Seite von the comments field zum Inhalt in Pixel fest.

User Interface > Innenabstand rechts

Legt den Abstand von der rechten Seite von the comments field zum Inhalt in Pixel fest.

User Interface > Innenabstand oben

Legt den Abstand von der oberen Seite von the comments field zum Inhalt in Pixel fest.

User Interface > Innenabstand unten

Legt den Abstand von der unteren Seite von the comments field zum Inhalt in Pixel fest.

User Interface > Breite linker Rand

Zeigt einen Rand auf der linken Seite von the comments field in der eingegebenen Breite (Pixel).

User Interface > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

User Interface > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von the comments field in der eingegebenen Breite

(Pixel).

User Interface > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.
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User Interface > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von the comments field in der eingegebenen Breite (Pixel).

User Interface > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

User Interface > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von the comments field in der eingegebenen Breite

(Pixel).

User Interface > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

User Interface > Date Format

Format in the user interface for dates. Use d for the day, m for the month and Y for the year.

User Interface > Name

Text in the user interface for Name.

User Interface > E-Mail

Text in the user interface for E-Mail.

User Interface > Message

Text in the user interface for Message.

User Interface > Cancel

Text in the user interface for Cancel.

User Interface > Send

Text in the user interface for Send.

User Interface > Password

Text in the user interface for Password. Note: This the text only if you want to translate the user

interface to another language. Change the password itself at Project > Admin Password.
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19. Store
Create a store and add products and a shopping cart to your website and start your

business online.

INFO: The shopping cart and product button is only available in Goldfish professional. 

PRO

Goldfish allows you to add a store to your website in only minues. You need at leat two differnet

items: A product button and a shopping cart. To add product buttons and a shopping cart, edit the

content of a page area or area template and drag the shopping cart and the product buttons from

the elements panel to the editor.

There are now several buttons on your website. A button for the shopping cart and at least one

product button. If the visitor of your website clicks on a product button, the product flies to the

shopping cart and is displayed in a badge. If the visitor clicks on the shopping cart, he can

checkout and submit the order.

To set up the shopping cart, click on it and the properties of the shopping cart are displayed.

Enter your e-mail address at Shopping Cart > E-Mail Address. All orders will be sent to this e-mail

adress via e-mail.
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To set up a product button, click on it and the properties of the product button are displayed.

Enter the product id for your product. Then enter the name, price and the label. The label is

displayed as text in the button.

Now your store is complete and ready for orders.

INFO: Dieses Objekt verwendet PHP. Ihr Webserver muss PHP unterstützen um es zu

nutzen.

Properties for Shopping Cart
These properties can be set for a shopping cart. Select a shopping cart to show its properties.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.
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Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.

Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Shopping Cart > E-Mail Address

Enter the e-mail address to which the orders will be sent.

Shopping Cart > E-Mail Subject

Subject in the e-mails for the customer and the store owner.

Shopping Cart > Currency

Currency for orders.

Shopping Cart > Decimal Point

Decimal point for currency formatted numbers.

Shopping Cart > Tax (%)

Tax ammount for all orders.
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Shopping Cart > Tax Included

Enable this if the tax is included in the prices of the products. Otherwise the tax will be added to 

Estimated Total.

Shopping Cart > Shipping Fee

The shippng fee that will be added to all orders.

Shopping Cart > Payment Options

List of payment options, that are supported in the store. Note that payments are not implemented

in the store. The choosen payment will only be included in the e-mail from the store. You must

handle playments manually.

Shopping Cart > Countries

A list of countries to that you want to deliver.

Shopping Cart > State

Adds a field for the state to the order process (needed for US and Canadian addresses).

Shopping Cart > Terms and Conditions

Adds a checkbox for terms and conditions to the order process.

Shopping Cart > Comment

Adds a field for comments to the order process.

Page Background > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für the shopping cart page.

Page Background > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Page Background > Hintergrundbild

Wählen Sie ein Hintergrundbild für the shopping cart page. Mit Wiederholen können Sie einstellen

wie das Bild angezeigt werden soll.

User Interface > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für the shopping cart.

User Interface > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.
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19: Store

User Interface > Hintergrundbild

Wählen Sie ein Hintergrundbild für the shopping cart. Mit Wiederholen können Sie einstellen wie

das Bild angezeigt werden soll.

User Interface > Innenabstand links

Legt den Abstand von der linken Seite von the shopping cart zum Inhalt in Pixel fest.

User Interface > Innenabstand rechts

Legt den Abstand von der rechten Seite von the shopping cart zum Inhalt in Pixel fest.

User Interface > Innenabstand oben

Legt den Abstand von der oberen Seite von the shopping cart zum Inhalt in Pixel fest.

User Interface > Innenabstand unten

Legt den Abstand von der unteren Seite von the shopping cart zum Inhalt in Pixel fest.

User Interface > Breite linker Rand

Zeigt einen Rand auf der linken Seite von the shopping cart in der eingegebenen Breite (Pixel).

User Interface > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

User Interface > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von the shopping cart in der eingegebenen Breite (Pixel).

User Interface > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

User Interface > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von the shopping cart in der eingegebenen Breite (Pixel).

User Interface > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

User Interface > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von the shopping cart in der eingegebenen Breite (Pixel).

User Interface > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

User Interface > Font Style

Choose the font style for the shopping cart.

- 99 -



19: Store

User Interface > Items

Text in the user interface for Items.

User Interface > Item Price

Text in the user interface for Item Price.

User Interface > Quantity

Text in the user interface for Quantity.

User Interface > Item Total

Text in the user interface for Item Total.

User Interface > Shipping Fee

Text in the user interface for Shipping Fee.

User Interface > Tax

Text in the user interface for Tax.

User Interface > Estimated Total

Text in the user interface for Estimated Total.

User Interface > Close

Text in the user interface for Close.

User Interface > Checkout

Text in the user interface for Checkout.

User Interface > Back

Text in the user interface for Back.

User Interface > Next

Text in the user interface for Next.

User Interface > Submit Order

Text in the user interface for Submit Order.

User Interface > First Name

Text in the user interface for First Name.

User Interface > Last Name

Text in the user interface for Last Name.
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User Interface > Street

Text in the user interface for Street.

User Interface > Zip/Postal Code

Text in the user interface for Zip/Postal Code.

User Interface > City

Text in the user interface for City.

User Interface > Country

Text in the user interface for Country.

User Interface > Phone

Text in the user interface for Phone.

User Interface > E-Mail Address

Text in the user interface for E-Mail Address.

User Interface > Reenter E-Mail Address

Text in the user interface for Reenter E-Mail Address.

User Interface > Payment

Text in the user interface for Payment.

User Interface > Personal Information

Text in the user interface for Personal Information.

User Interface > Thank You Message

Text in the user interface for the thank you message..

Properties for Product Button
These properties can be set for a product button. Select a product button to show its properties.

Objekt > Abstand von links

Legt den Abstand von der linken Seite des Elternelements in Pixel fest.

Objekt > Abstand von oben

Legt den Abstand von der oberen Seite des Elternelements in Pixel fest.

Objekt > Breite

Legt die Breite des Objekts in Pixel fest.
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Objekt > Höhe

Legt die Höhe des Objekts in Pixel fest.

Objekt > Innenabstand links

Legt den Abstand von der linken Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand rechts

Legt den Abstand von der rechten Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand oben

Legt den Abstand von der oberen Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Innenabstand unten

Legt den Abstand von der unteren Seite von dem Objekt zum Inhalt in Pixel fest.

Objekt > Hintergrundfarbe

Wählen Sie eine Hintergrundfarbe für das Objekt.

Objekt > Hintergrundclip

Wählen Sie ein Hintergrundbild aus der Goldfish Clipsammlung (

http://www.fishbeam.com/de/goldfish/clips.php). Diese Option ist nur verfügbar, wenn Sie die

Goldfish Clipsammlung installiert haben.

Objekt > Hintergrundbild

Wählen Sie ein Hintergrundbild für das Objekt. Mit Wiederholen können Sie einstellen wie das

Bild angezeigt werden soll.

Objekt > Breite linker Rand

Zeigt einen Rand auf der linken Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe linker Rand

Wählen Sie eine Farbe für den linken Rand.

Objekt > Breite rechter Rand

Zeigt einen Rand auf der rechten Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe rechter Rand

Wählen Sie eine Farbe für den rechten Rand.

Objekt > Breite oberer Rand

Zeigt einen Rand auf der oberer Seite von dem Objekt in der eingegebenen Breite (Pixel).
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Objekt > Farbe oberer Rand

Wählen Sie eine Farbe für den oberer Rand.

Objekt > Breite unterer Rand

Zeigt einen Rand auf der unteren Seite von dem Objekt in der eingegebenen Breite (Pixel).

Objekt > Farbe unterer Rand

Wählen Sie eine Farbe für den unteren Rand.

Objekt > HTML Code hinzufügen PRO

Fügt dem Objekt eigenen HTML Code hinzu um die Funktionalität von Goldfish zu erweitern.

Objekt > Stylesheets hinzufügen PRO

Fügt dem Objekt eigenen CSS Code hinzu. Der Code wird im CSS Bereich Ihrer Website

gespeichert. Sie können den CSS Code von eingebauten Komponenten nicht verändern, aber

Sie können die hier hinetrlegten CSS Klassen in Ihrem eigenen HTML Code verwenden.

Objekt > Identifer (Id) PRO

Setzt den Wert für die id Eigenschaft. Sie können diese für den Zugriff auf das Objekt mit

JavaScript verwenden.

Product Button > Product ID

The product id (item number) of the product. If you have two buttons with the same product id,

they refer to the same product.

Product Button > Product Name

Name of the product. This will be shown in the shopping cart.

Product Button > Price

Price of the product. The currency and tax is set in the shopping cart.

Product Button > Differing Tax

Enable this if the tax for this product differs from the global tax which is set in the shopping cart.

Product Button > Label

The text in the product button.

Product Button > Alignment

Alignment of the text in the product button.

Product Button > Font Style

Style of the text in the product button.
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Product Button > Innenabstand links

Legt den Abstand von der linken Seite von the product button zum Inhalt in Pixel fest.

Product Button > Innenabstand rechts

Legt den Abstand von der rechten Seite von the product button zum Inhalt in Pixel fest.

Product Button > Innenabstand oben

Legt den Abstand von der oberen Seite von the product button zum Inhalt in Pixel fest.

Product Button > Innenabstand unten

Legt den Abstand von der unteren Seite von the product button zum Inhalt in Pixel fest.
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20. Publish Website
Publish your website immedialtely on the internet with the built in ftp client.

You need a web server to publish your website on the internet. Usually a website hosting service

will provide you access to a web server, but you can also operate a web server by yourself.

INFO: Goldfish will not help you to find a hosting service or register a domain like 

www.mywebsite.com. But you can find many hosting services with Google (

http://www.google.com).

The code files which Goldfish creates must be uploaded to your web server (blue cloud). The

visitors of your website get in touch with your webserver and receive your website from there.

If your website is complete you can publish it directly from Goldfish with the built in ftp client. You

need ftp access to your web server to publish your website. Choose File > Publish Website... from

the menu.
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Enter the address of the ftp server, the user name and password. And click on OK. The

webserver will be connected. A list of folders from your web server is shown. You can publish

your website here or navigate to a sub folder with doubleclick. Click on Publish to publish your

website.

INFO: Goldfish remembers all ftp logins which you have entered. You can choose a recent

login with the pulldown menu at the server field. If you activate Remember Password, the

password will be remembered as well.
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If there is an older version of your website on the web server, the button Publish changes to 

Update. Click on Update and Goldfish updates your website. Only the new and changed files are

uploaded.

During the build process, there may occure build errors. There are several types of build errors.

 - The e-mail address is missing: You have an e-mail form or shopping cart on your website,

but there is no e-mail adress to which the data will be sent. Enter the missing e-mail address

and click on OK

 - The internet address is missing: You have a rss newsfeed on your website, but the internet

adress is missing. The internet address is needed, by rss feeds. Enter the internet address

(e.g. http://www.mywebsite.com) and click on OK.

 - The admin password is missing: You have a comment field on your website but the

password administration purposes is missing. The password is needed if you want to delete

comments. Enter a password and click on OK.

 - There are multiple shopping carts on a page: You have a page with at least two shopping
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carts. It makes no sense to have multiple shooping carts on a page. Delete all redundant

shopping carts and built your website again.

 - A shopping cart is missing: You have a page with at least one product but there is no

shopping cart to buy it. Add a shopping cart to the page or area template and built your

website again.

INFO: If you want to build your website on the desktop, choose File > Build Website...

instead of File > Publish Website....
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21. Build your Website
Build your website on the desktop and get all neccessary files, which you can upload to a

webserver.

You need a web server to publish your website on the internet. Usually a website hosting service

will provide you access to a web server, but you can also operate a web server by yourself.

INFO: Goldfish will not help you to find a hosting service or register a domain like 

www.mywebsite.com. But you can find many hosting services with Google (

http://www.google.com).

The code files which Goldfish creates must be uploaded to your web server (blue cloud). The

visitors of your website get in touch with your webserver and receive your website from there.

If your website is complete you have to build all neccessary code files and media for the

webserver. Choose File > Build Website... in the menu and choose a destination on your hard

disk where Goldfish can save the files.

INFO: Don't upload the .gfp file to your webserver. This file contains your website project

and can't be read from a webserver. Always upload the files which you get from File >

Build Website....
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During the build process, there may occure build errors. There are several types of build errors.

 - The e-mail address is missing: You have an e-mail form or shopping cart on your website,

but there is no e-mail adress to which the data will be sent. Enter the missing e-mail address

and click on OK

 - The internet address is missing: You have a rss newsfeed on your website, but the internet

adress is missing. The internet address is needed, by rss feeds. Enter the internet address

(e.g. http://www.mywebsite.com) and click on OK.

 - The admin password is missing: You have a comment field on your website but the

password administration purposes is missing. The password is needed if you want to delete

comments. Enter a password and click on OK.

 - There are multiple shopping carts on a page: You have a page with at least two shopping

carts. It makes no sense to have multiple shooping carts on a page. Delete all redundant

shopping carts and built your website again.

 - A shopping cart is missing: You have a page with at least one product but there is no

shopping cart to buy it. Add a shopping cart to the page or area template and built your

website again.

INFO: If you want to publish your website immediately on the internet, choose File >

Publish Website... instead of File > Build Website...
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22. Import Media
Learn how you can import and process media files like images, movies and documents in

Goldfish.

Every time if you import media files (images, movies, pdf and other media), the media import

window appears. An imported media file gets included into the .gfp file. So if you pass the .gfd file

to others, it's not neccessary to pass the media files as well.

There is a preview, if you import pictures (.jpg, .png, .gif). You can also resize, rotate or flip the

pictures, so that your .gfp file gets not too big. This is recommended if you import large images

directly from a digital camera. 700 x 700 px are adequate in most cases. The resize function

resizes the picture only if it's bigger than the entered values. It resizes in aspect ratio.

INFO: The image manipulation functions are only available for .jpg and .png images. Not

for .gif images.
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You may enter a description for every imported media file. This description is used in many ways:

 - As alt text in html code for images.

 - As tooltip for links to the file (e.g. to a .pfd file).

 - As description for images in a gallery.

To edit the description or a file name, select nothing so that the properties for the project are

shown. Click on Project > Embedded Media > Choose... and the embedded media window

appears. Double click on a description to edit it

Double click on a name to edit it. Note that you can only use letters, numbers and _ for the name.

Don't remove the suffix. There is also a length restriction. If you have entered a bad name, it won't

be accepted.
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23. Working with Fonts
There are several things you should know if you work with fonts and font styles on

websites. 

Fonts and font styles are handled in font templates. Select nothing (the project properties appear)

and click on Project > Font Templates > Choose... on the properties panel. A list of all font

templates appears.

The first template on the list is the Master Template. Here you can store the default font style for

your website. If you don't set a special font for all other font templates, or components, the style of

the master template is used. Double click on a font template to rename it.

 Add a font template.

 Duplicate a selected font template.

 Delete a selected font template.

 Opens the font editor and you can edit the font template.

Click on the Edit Font Template button. The font editor will be opend.
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The following option can be set in the font editor. Note that there are sometimes not all options

avaiable. It depends on the item from which you edit the font style.

Font template

Choose the font template, on which the font style is based. The style is taken from the font

template.

Font

Activate this to overwrite the font from the font template.

Style

Activate this to overwrite the font style of the font template.

Size

Activate this to overwrite the font size of the font template.

Color

Activate this to overwrite the color from the font template.

Line space

Activate this to overwrite the line space from the font template.

Alignment

Activate this to overwrite the alignment of the font template.
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INFO: If you change the style in a font template, this changes apply to all font styles which

use this font template and where the changed style property isn't overwritten.

A font can only be displayed if the visitor has it installed on his computer.  So it's better to declare

a list of fonts, where the first font which is found will be used. Click on the button Alternative font

family next to the font selector.

 Add an alternative font family.

 Delete a selected alternative font family.

The list is processed from the top to the bottom. The first font which is found on the visitor's

computer is used.
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24. Creating Webapplications
Create web applications with Goldfish Professional in your prefered language (e.g. PHP).

INFO: Creating web applications in this form is only possible in Goldfish professional. 

PRO

In this example you will sell how simple it is to create a php web apllication in an external source

code editor and include it in a Goldfish project.

A php script has usually the suffix .php. In Goldfish you can set the suffix for code files in the

preferences. Choose Goldfish > Preferences... from the menu (Edit > Preferences... in Windows).

The preferences window appears. Enter php at Suffix of code files on the tab Create Website.

In this example, we use a simple php script that calculates the time which the visitor of your

website spents there. The program code itself is stored in an external file, created in an external

source code editor.
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 <h1>PHP Session Test</h1>

 <?php

 //Save time of the first visit in the session

 if(!isSet($_SESSION['startTime'])) {

    $_SESSION['startTime']=mktime();

 }

 //Print time delay since now

 echo '<p>You are visiting this website for '.(mktime()-$_SESSION['startTime']).' seconds

now.</p>';

 ?> 

If you have saved the file on your hard disk, drag it into your Goldfish project. It will be included as

an alias. That means only the path to the file is stored in the project. The file itself remains on

your hard disk. You can still modify it with an external editor and Goldfish publishes the changes if

you publish your website.

INFO: Goldfish supports also aliases to folders with subfolders, code files, images and

other media. Just drag everything that is needed by your scripts in the project.

Properties for Alias
These properties can be set for an alias. Select an alias to show its properties.
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Alias > Menu Title

The menu title will be displayed in all navigation menus, who contain a link to this file. Disable it

and the file is not shown in the menu.

We want to execute the script on the start page. Select the start page and click on the page area

on it so that the properties of the page area are visible. Click on Page Area > Add HTML Code

and enter the following code. This connects the script with the start page.

<?php include 'script.php'; ?>

If you want to use sessions in php, it is required to initialize the session before any html output

begins. In Goldfish you have access to the first line even before the html document begins. Select

the start page and click on Page > Add Code Before Document and enter the code below, This

initializes the session so that it can be uses by your script.

<?php session_start(); ?>

The script prints text on the screen. To change the style of the text, click on the page area and
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click on Page Area > Add CSS Code in the properties. Enter the style below. It adds a padding

and sets the page area transculent.

 padding-left:10px;

 filter:alpha(opacity=80);

 -moz-opacity: 0.80;

 opacity: 0.80;

Now your web application is complete. You can change the background and add a border to

make it cooler. Publish the website and reload it several times in the browser. The time display

will increase.

INFO: If you have scripts that handle the complete html output of a page, you can enable 

Page > Disable HTML Code Output. Goldfish creates a blank page then without any html

code. You can add your own html code with Page > Add HTML Code then or connect it

with a script.
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25. Export a Design
Export your work as Goldfish design. Build websites from your design or deliver it to your

clients.

A Goldfish design is a design template for Goldfish websites. Choose File > Designs... from the

menu to see all installed designs. Technically a design is a Goldfish project which contains the

complet layout of a website but no content.

To export a design, choose File > Export > Design... from the menu. Click on the Goldfish icon

and paste a screenshot from your design. This is used in the designs window as preview. You

can also enter a description or copyright text.

Click on OK to save your design. Goldfish Design files have the extension .gfd instead of .gfp.
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26. Preferences
In the preferences, you can change the behavior of Goldfish.

Choose Goldfish > Preferences... (Edit > Preferences... on Windows) and the preferences

window appears. The perefernces are seperated in two areas. General and Craete Website.

General
The follwoning perferences can be set on the General tab.

Search for updates at Startup

Searches at every startup of Goldfish for updates on our website. You will be notified if there is an

update available.

Use alignment guides

Use alignment guides to guide you with the layout of your website. You can drag an alignment

guide from the rulers.

Show area alignment guides on pages

If you have alignment guides on template areas, they will be shown on the page area that uses

the template area.

Snap alignment guides to object positions

if you drag an item, it will snap to an alignment guide near by.
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Use sound effects

Plays sounds if there is an update available.

Close areas in the properties automatically

If you activate this, there is kept only one area open in the properties.

Create Websites
The follwoning perferences can be set on the Create Websites tab.

Name of index file

Usually, the file, which is loaded at first if the visitor enters your website is named index.htm.

Rename this if your website hosting service requires a differnent name.

Name of media folder

Here you can rename the folder for media files of your website. This is required if you create a

page with subpages which is called media, too.

name of support folder

Here you can rename the folder for support files of your website. This is required if you create a

page with subpages which is called support, too.

Suffix of code files

Here you can change the suffix for code files. Usually the extension is .htm. Some website

hosting services require .html instead.

Text encoding

Change the encoding if special characters (ä, ©, ß...) are displayed wrong on your website

JPEG export quality

Sets the quality for new calculated jpeg images. A lower quality makes smaller file sizes.
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27. Trouble and Errors
Learn what you can do if errors occure, if you find bugs or if you have trouble using

Goldfish.

Letters like ©, ä and ß are not displayed correctly on your website: Choose Goldfish >

Preferences... (Edit > Preferences... on Windows). Change Text Encoding on the tab Create

Website. If you export the website again, the characters will be displayed correctly.

When the visitor sends the form on your website, php code is shown and the visitor counter is not

displayed: Your website hosting service doesn't support php. Upgrade your websosting package

so that php is supported or remove all items which use php (visitor counter and form) from your

website.
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27: Trouble and Errors

Please fill out all fields if you see this message and describe what caused it. This is a bug of

Goldfish and your feedback helps us to improve our software.
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28. Goldfish Short Keys
Learn how to use Short Keys in Goldfish. This article contains a full list of all short keys

for Goldfish.

Application Start
 - Reset preferences

Preferences
 - Show advanced preferences

Edit Page
 - Delete selected Page Area

 - Leave edit mode

Edit Page Area
 + Click - Add or remove to selection

 - 1 px. left

 - 1 px. right

 - 1 px. up

 - 1 px. Down

 - Delete selected items

 + Resize item - Resizes in aspect ratio

 - Leave edit mode

Edit Page Item
 - Leave edit mode

Edit Text
 - Go right *

 +  or  +  - Line end *

 +  - Next word *

 - Go left *

 +  or  +  - Line start *
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 +  - Last word *

 - Go up*

 +  - Text start *

 - Go down *

 +  - Text end *

 - Delete text left

 - Delete text right

* If you press also , the text will be selected.
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